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Adviser and Manager are whole farm planning, 

paddock based recording, reporting and mapping 

software programs. Both programs can assess 

profitability and risk as you plan and come with a 

comprehensive list of crop, variety and chemical 

inputs, and all can be easily added or edited. 

 

Plans can be viewed as maps with links to soil 

samples. The farms physical resources such as soil 

types, tree plantings and contours can also be 

displayed on a map.  A farm rotation analyser and 

a crop water use calculator are added features. 

 

Adviser and Manager programs are powerful, 

accurate, easy to use and compliant with most 

management systems including yield and paddock 

maps from farm machinery. 
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About Adviser / Manager 

BACKGROUND TO THE SOFTWARE 
Adviser was originally developed to provide Agronomists with a means to quickly provide their 
clients with detailed paddock-based agronomic plans for the coming season while allowing the 
flexibility to modify the plan as the season progressed. 

Those who previously had systems based around combinations of word processors, spreadsheets 

and databases found Adviser to be a single comprehensive solution that reduced preparation time 

substantially and provided a more integrated and professional looking product. 

The software has continued to evolve and expand to suit the requirements of farmers as well as 

Advisers while maintaining ease of use and the original core aims of the software: 

 To provide fast and efficient agronomic planning 

 Reduce repetition and save time 

 Utilise data to provide useful information to help with decision making and communication 

 

Adviser software is to be used as an integral piece of farm machinery throughout the entire farming 
year. We believe it can add much value to a farm business by improved planning, communication 
and informed decision making 

 

ADVISER EDITIONS 
The Adviser family of software is available in several flavours to suit different user requirements and 

budgets. 

 Adviser is aimed at Consultants, Advisers, Agronomists or anyone who needs to use the 

software for Multiple Clients. 

 Manager is aimed at farmers or those who wish to use the software for a single farm 

business entity.  Manager does not include all the functions of Adviser 

Both of these versions are available in “Lite” versions that do not include GIS Mapping and a number 
of other features. 
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USING THIS GUIDE 
Throughout this guide the following symbols are used to help you better understand the software. 

These are: 

 
Exercises 

These are “hands-on” practice runs that will guide you 
through all the steps to complete a key task 

 Pointers 
Useful tips to help you avoid some of the pitfalls of 
new users 

 Table Layout 
An explanation of the data fields that you will 
encounter in the data entry tables as you use the 
software 

 

Another convention that you will encounter is the “Menu Path” These are used to indicate which 

menu commands you use to achieve a specific function. For example, to close the program you 

select the File menu and then the Exit menu contained in the File menu. The menu Path form of this 

is [File/Exit]. A more advanced example could be [Mapping/Layer Library/Saved Layers/Retrieve]. 

Simply start at the main application Menu and work your way through. 

Similarly Keyboard Shortcuts are denoted by [ ] 

The Guide has been structured to take you through each section of the software in a logical manner 

to get you up and running as quickly as possible. The Guide has been designed to be flexible for use 

as either a self-paced tutorial, training course notes and as a reference source as required. 
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Chapter 1 – Getting started 
In this chapter you will familiarise yourself with licencing the software, requesting support, the 
software user interface and the process of getting ready to set-up your first Client File. 

1.1 LICENCING 

Licence Manager 
 

The licence manager is accessed through the Help section via the command [Help > Licence 
Manager]. This will then bring up the licence manager window where information on advisor 
licences can be obtained. There are four sections in the licence manger that consist of the licence 
current status, licence product comparison, licence agreements and licence requests. 

Licence Current Status 

This window displays the status information on the licence currently used by the computer. The 
status of the licence is then displayed in the right hand section along with the expiry date, last 
accessed date, issue date, current time and product configuration. 

Product Comparison 

The product comparison section shows a table with all products offered by Back Paddock Company. 
In the neighbouring columns are the products description and its limitations. This section is 
important in determining what product would best be suited for your particular needs.  

Licence Agreement 

This particular section of the report displays the licence agreement for the software 

issued. It is important that this is read and understood before purchasing and using the 

software. 

Licence Request 

The licence request section has three aspects to it, which consist of the user details, privacy 

statement and request licence.  

1. The user details section determines which product you wish to request and also the name and 

location for the software. Choose a particular product and then enter in the details below.  

2. The privacy statement then explains that all the information provided to Back Paddock Company 

is kept confidential.  

3. The request section then displays the particular product and issue length at the top of the 

window. If the information is correct then simply click on the send email request to obtain the above 
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product. To save the request form for another time, simply click on the save request file and it will 

be saved in a particular location for future reference. 

1.2 SUPPORT 
 

The help section at the top of the page can be used to describe certain aspects about the program, 

access the Back Paddock Company website, display licence manager, check for updates and “Open” 

the support page. 

If any problems are encountered whilst using this program there are a number of options that can 

be used to overcome the problem or situation. The first step would be to find the particular section 

in this users guide and follow the steps and procedures as followed. If the problem persists or is not 

found within the report then other options can consist of:  

1. Contact Free call help desk on 1800 557166 during 7am-7pm EST 

*If issues with the software, users must be on the latest version so under help check for updates 

when on line before contacting the help desk as often an enhancement in the latest version 

may satisfy your enquiry.  

2. Group Training – Back Paddock Adviser/Manager training is available in group sessions with a 

minimum number of 10 required. Manager and Manager Lite training can attract government 

subsidies such as FarmBis. All training delivered by Certificate IV, Training and assessment 

accredited trainers.  

3. Master Data Base - an up to date Master Data base can be emailed to users upon request and 

includes the most of the current seed varieties, fertilisers, operations, timings and chemicals 

that could be used on farms in Australia. Default costs and application rates are also included. 

4. Demonstration CD copies - available free upon request, email a request to 

support@backpaddock.com.au, or phone 1800 557 166. The demonstration CD allows users to 

adjust details in two paddocks of a sample farm file. Also included is a video explaining the 

features of Back Paddock Adviser/Manager, a tutorial and a testimonial by an experienced user.  

5. Customised reports - detailed customised reports can be created on a fee for service basis. 
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Chapter 2 – Setting Up the Farm 
In this Chapter you will learn how to set up the Client File with farms and their associated 
paddocks. This will form the backbone of all future work done on this file and the 
presentation of summaries and Reports. 
 

FILE MANAGEMENT 
 

The native document type for Adviser is the "ADV" file. This file can contain data for any number of 
farms, paddocks and management zones for any number of years. 
 
It is usual for one client file to contain the data of one farm business entity. 
 
To create your initial Client File, complete Exercise 1. After this exercise you will be ready to start 
adding farms and paddocks, which is covered in the next chapter. 
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 

Exercise 1 
Create a new Client File  
 

 Select New From the File menu (or the New 

button  on the Toolbar)  
 Check that the path to the correct Drive and 

Folder is correct so you will place it where 
you want it and you can find it later. 

The recommended and default location for client 
files is in; 

My Documents/Back 
Paddock/Software/Adviser/Clients  

This Folder is created during installation and is 
default location when you create a new file. 

 Enter a name for the file 

 Naming Client files by the farm business name is 
the preferred practice. This name can be used 
later in report headers. 

 
 A filename can contain up to 255 characters, 

including spaces. But, it cannot contain any of 
the following characters: 

\  / :  *  ?  "  <  > 

 

 It is essential that the file has the “.adv” 
extension. It is possible to accidentally change 
the file name extension when renaming files. 

 

 Select Save to create new file  
 

Your newly created file will now be open ready to 
start entering data. 

If it is necessary to change a file name, this can be 
done in the “Open” File Box (select client file and 
click right mouse button), or alternatively in 
Windows Explorer.   

 

 
 
 
 
 

 

CLIENT DETAILS 
Each Client File can contain client information to be 

used when printing reports or as a general 

reference. 

To view or edit Client details go to menu [File > 

Client Options+. This will “Open” the Client Options 

dialog. Select the Client Details tab and edit fields 

as required. 

BACKING-UP & SAVING DATA 

Before we move on we will cover the very 

important topic of making sure you do not lose 

your data once you have invested the time in 

entering it. 

HOW DOES ADVISER SAVE 
DATA? 
While you are entering data the software 

constantly writes changes to your client file after 

updating each entry. 

You can easily tell when this occurs as when you 

start to edit the symbol at the left of the table row 

you are editing changes to a . After editing is 

complete and the data is saved to disk the symbol 

changes to a . There is no need to manually save, 

as this is automatic each time you update. If the 

program crashes or the computer is closed the 

data will remain intact provided the storage disk is 

operational. To protect against a loss of storage 
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 
Pointers for Backing-Up Data 

 

 Get in the habit of backing-up client files after 

each time you make significant changes 

 If you lose the client file you will have to start 

again from scratch. The file is an investment of 

your time. You can never have too many 

backups. 

 We have heard from many devastated users 

who did not back-up their file. Some examples 

are; 

o Laptop stolen from car 

o Hard disk failure 

o Accidentally overwrote or deleted file 

o Electrical storm fried PC 

 A backup saved in a different location would 

have prevented loss in all these cases 

device you must make a back-up copy to a different storage device. 

 
 

BACKING-UP CLIENT FILES 
To back-up your client file the easiest method 

is to use the Export/Backup Client File As… 

Menu command located on the File Menu 

[File> Export> Backup Client File As…]. 

This function “Opens” a standard Windows 

save dialog where you can direct it to a new 

location. If desired you can also rename the 

file at this time. 

Examples of where to back-up are: 

 USB Thumb drive 

 Burn to CD 

 A networked hard  

drive on a different  

PC 

You can back-up the file anywhere data can 

be stored. 

Alternatively you can back up files manually 

using Windows Explorer. 

SAVE CLIENT FILE AS… MENU COMMAND 

This command is only used when you wish to save the Client file as a different name and make the 

new name the active file. The existing file remains unchanged after this point. This is useful for doing 

“What if” scenarios, though much care should be taken to ensure data remains complete in the 

desired file.  

It is not recommended that this function be used to back-up data. 
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The initial step in creating a new client file is to set up the client details. To do this, go to [File>Client 

Options]. This will bring up an additional window that will enable you to enter all the relevant details 

for the particular client file. 

 

The next step in configuring a new Client File is to set up the farm. Once farms and paddocks are 

added the program is ready to go. 

Click on the Farm Tab at the top of the page to proceed in setting up your farm. 

 

MULTI-FARM 
By default one farm called “Home Farm” is created at the time of file creation. If there is only one 

farm for the client file then you may wish to change the name of the farm. This is done in the Multi-

Farm section. Press the  button to view this. 

The Multi-Farm dialog provides the following functions: 

Add a New Farm 

1) To add a new farm, press the Add button.  

2) Name the new farm and any other details in the table.  

3) Close the Multi-Farm dialog when complete. 
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Changing farm sort order 

You can change the order of farms by selecting the row containing the farm you wish to move and 

then pressing either of up or down buttons in the toolbar.  

This order is used for all navigation and presentation throughout the program. 

Deleting Farms 

To delete a farm, select the row of the farm you wish to delete and press the Delete button.  

 NOTE THAT DELETING A FARM WILL PERMANENTLY DELETE ALL DATA FOR THAT FARM 

INCLUDING ALL PADDOCKS, ALL INPUTS FOR ALL YEARS. USE WITH CAUTION!! 

Report Images 

In the Report Images dialog you can add graphics files to be included in the report. These could be: a 

diagram, photo or map or any bitmap or jpeg file. These will appear in reports before the farm they 

are linked to. Take care to not use images that are too large and can fit within A4 page margins. 

 

 

 

Multi-Farm Data Details 

 

 

 

 

SETTING-UP PADDOCKS 
The paddock table on the Farm page allows you to allocate any number of paddocks to a particular 

farm. The table can only include the paddocks from the currently selected farm. 

This is set by using the drop list on the toolbar. If there is only one farm in the Client file then there is 

no need to set the current farm. 

 

 

 
The Restructure Paddocks section allows you 
to change farm structure without data loss. 
This is covered later. 

 

 

 Table Layout – Farm Table (Multi-Farm Box) 
 

Exclude  Excludes selected paddock from Navigation, summaries and reports 

Farm Name  Name of farm to be presented throughout all displays 

Rainfall O Average annual rainfall for farm  

LocationID O Unique farm ID for use in Adviser Analyser software 

Notes  Any permanent details for the farm 
O = optional 
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 When initially setting up the farm you may wish to use the 

Quick Entry feature, which can be seen below. 
 

 

 

 

 

Adding Paddocks 

Having selected the current farm (if more than one farm) you can begin to add paddocks. To do this, 

select the Add button on the toolbar.  

The cursor will be ready in the Paddock Name cell so you can begin typing the name immediately. 

Hit the Enter key  and the cursor will move to the Area cell where you can type the paddock area 

immediately.  

Quick Entry 

The Quick Entry feature  allows you to automatically add a new paddock after editing the 

area cell and pressing the Enter > Return key  on the keyboard. This can make it easy to work 

through a list of paddock names and areas using minimal keystrokes.  

Be careful when on the last paddock not to add an extra paddock. If you do, then simply delete the 

surplus paddock. 

Insert Paddock 

The Add button always adds a paddock to the bottom of the list. Alternatively you can insert a 

paddock by selecting the paddock that you wish a new paddock to appear above and then selecting 

the Insert button  instead of the Add button. A new paddock appears above your current 

selection. 

Deleting a Paddock 

To delete a paddock, select the row of the paddock you wish to delete and press the Delete button. 

 

NOTE THAT DELETING A PADDOCK WILL PERMANENTLY DELETE ALL DATA FOR THAT PADDOCK 

INCLUDING ALL INPUTS FOR ALL YEARS. USE WITH CAUTION 

Sorting Paddock Order 

You can change the order of paddocks by selecting the row containing the paddock you wish to 

move and then pressing either of up or down buttons in the toolbar, to move the paddock in that 

direction.  This order is used for all navigation and presentation throughout the program. 
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 Table Layout – Paddock Table (Farm Tab) 

 

Exclude  Excludes selected paddock from Navigation, summaries and reports 

Paddock Name  Name of paddock to be presented throughout all displays 

Area  Area in Ha to be used as default throughout 

Soil Details O Description of soil type for paddock 

Boundary (not included in Lite versions) Press to “Open” paddock boundary editor in mapping 

Arable (not included in Lite versions) Press to “Open” paddock arable area editor in mapping 

Rain Site O Rainfall collection site relevant to this paddock 

Notes O Any permanent details for the paddock 

   O = optional  

Pointers for setting-up the farm 

 
 Start by re-naming the Home Farm and adding any additional farms in the Multi-Farm 

section 

 Add paddocks to each farm in the order you wish them to be presented throughout 

the program 

o Enter paddock area as you go as this is important later when you start 

entering data 

 Be careful not to include any typo’s such as extra spaces in names as these will be 

used throughout the entire package 

 Take care not to add additional paddocks (particularly when using Quick Entry mode) 

or farms that are not required as this can cause problems later on 

 

 

 

PADDOCK TABLE DATA DETAILS 
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 

Exercise 2 
Adding Farms and Paddocks  
 

 

1. Use the Client file you created in Exercise 1. If this is not already “Open” then 

“Open” it now. To “Open” use either the Menu [File/”Open”] or the “Open” Client 

button on the toolbar.   

2. Select the Farm Tab on the Main Screen 

3. Select the Multi-Farm button on the Toolbar 

4. Place the cursor in the Farm Name cell and rename “Home Farm” to something else 

5. Select Add new farm 

6. Type a new farm name for the second farm. The cursor will be ready to overwrite 

the default “New Farm 2” name. 

7. Select the second farm and change the sort order up and down. 

8. Close the Farms Dialog 

9. Select a farm that you wish to add paddocks to using the drop list on the Farm View 

toolbar 

10. Select the Add button and then type a new paddock name over the default “paddock 

1” 

11. Hit Enter  on the keyboard and then type the area of the paddock 

12. Press Quick Entry on the toolbar once to set Quick-Entry mode 

13. Add a new paddock as before 

14. Type the name and press enter  

15. Type the area and press enter  - A new paddock should have been added 

16. Repeat steps 14 and 15 until all desired paddocks are complete 
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Chapter 3 – Navigation 
In this Chapter you will get an initial feel for how the client file is structured for data 
associated with paddock operations. The concept of the Management Zone is to see how we 
input data and navigate to view the data we want to see. 
 

THE MANAGEMENT VIEW – WHERE IT ALL HAPPENS 
Most data entry in Adviser is performed in the Management View. This view is activated by selecting 

the Management Tab on the main Client screen. 

 

The Management View is dived into a number of Panes. With the exception of the Navigation Pane, 

all panes are used to enter or view data. 

MANAGEMENT ZONES  
The term “Management Zone” is used in Adviser to refer to a particular piece of land over a given 

timeframe. This is generally a paddock in a given year, though can be a part of a paddock in the case 

of split paddocks. Later you will see that inputs are allocated to Management Zones. This section will 

cover the methods of moving between Management Zones to select the sections related to them 

and allow you to view, add or edit data for a particular zone. 
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NAVIGATION PANE  
To move between paddocks you must use the Navigation Pane. 

Summary and Rotation scope can also be set using the Navigation Pane to select different levels 

such as All Farms, Selected Farm, Selected Paddock or Selected Usage. 

The Navigation Pane has several modes of presentation. These are: 

 

  Normal Mode - Tree shows hierarchy of Farms and 

Paddocks. See example to the left. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Crop Mode - Tree shows hierarchy of Crop type 

and Paddocks. See example to the right. 
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 Link Mode - Tree shows paddocks / master paddocks 

as parent nodes of any paddocks or management 

zones that are linked to them using paddock linking. 

See example to the left. 

 

 

 

 

 

 

 

 

 

 

 

 Map Mode - (not included in Lite versions) Paddock 

map allows navigation by paddock boundary selection 

or keyboard arrows. Use mouse wheel to zoom. See 

example to the right. 
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 The Farm Year can also be set using keyboard 
shortcuts. 
[ ] to move to the next year 
[ ] to move to the previous year. 

 

 

 

PADDOCK SELECTION 
In the non-map modes where a hierarchical tree is used, navigate by initially selecting a paddock 

from the tree. Selection of paddocks can then be by: 

 Selecting another paddock using the mouse 

 Using the up or down arrows on the keyboard 

 Typing the first letter of a paddock to move to (can be repeated until correct paddock is 

selected) 

THE FARM YEAR 
Data input and summary is considered in 

terms of a Farm Year. The Farm Year is set 

in the toolbar of the Management Zone 

Pane. To change year select the left or 

right buttons to move to the previous or 

next year respectively. By default the 

program opens in the current year. 

The Farm Year is not necessarily a calendar year. The starting month may be important for dates in 

the Cash flow or Diary sections. 

The starting month of the Farm Year can be set by selecting menu [File>Client Options] and 

choosing a month in the drop down list. 

PLAN & ACTUALS MODE 
While navigating, it is also important to be aware of the Plan status. By default a Client File opens in 

Plan mode. Plan mode is for looking forward to costs and actions that have not yet occurred. 

Throughout the year actuals can be added with the real situation without overwriting the plan. 

To switch between Plan and Actual mode press the button on the Main Toolbar. You can also use the 

menu command [View>Actuals]. 

 

 

 
 
 
 
 
 

 You can also toggle between Plan and Actual 
mode by using the keyboard shortcut  
[ ] 
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Chapter 4 – The Master Database 
In this Chapter you will find out about one of the single most powerful components of the software, 
The Master Database. You will learn how this database interacts with your Client File to reduce 
repetition and maintain consistency for summaries and reports. 

 

4.1 WHAT IS THE MASTER DATABASE? 
The Master database is common for ALL client files. Its purpose is to: 

 Save time by not having to retype product and other input names  

 Maintain default prices, yields and usage rates  

 Allow users to configure drop-down lists to their own specifications  

 Standardise terms and groupings for use in Reports, Summaries and History (Quality 

Assurance) 

The Master Database can be opened from the Tools Menu or tool button      

 

 

Prices in the Master Database are default only, and can be overwritten at any stage in the client file. 

Changes to the Master Database ARE NOT automatically reflected in Client files, though can be 

manually updated per year by using Tools > Update client from master. 
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When entering names, bear in mind that this is how they will appear in summaries and reports. Note 

also that the drop-down lists in the client files will sort these by alphabetical order and so the 

naming convention should facilitate the fast find feature of pressing the first letter of an input. 

The Master database is structured to allow you to Add, Modify or Exclude items under the headings 

– Crops/Fertilisers/Chemicals/Operations/Timings/Production/Livestock and General. 

Images as bmp files can be added in the Timings section and show in the Spray Program Report. 

Utilise the + and – buttons to collapse the branch and expose the contents under each heading i.e. 

Crops – Broadleaf/Fallow etc 

 You can utilise the EXCLUDE tick box (tick to exclude) to remove certain 

items from your drop down selections in PA that you do not wish to see. 

i.e. controls what appears in lists - certain Fertiliser suppliers or blends etc. 

Values are copied from the Master Database to Client Files when using Drop-List. These values then 

become part of the Client File and will remain as such until they are either overwritten or reselected 

from Drop-List. Using the Update From Master Command on the Tools Menu of the Main Program 

can refresh updated details in the Master.  

The Master database file “AdviserMaster.pm” is interchangeable with other users. By default this file 

is located under your \Back Paddock Software\Adviser\Master Data directory located in your “My 

Documents”. 

To share your Master Database with another user you are required to Export your database as a 

*.pm file by selecting File/Export Master As, selecting a directory where you wish to Save your 

database file and then giving the File a name in the File Name box. Select SAVE to create the file in 

the selected directory. 

When you have sent your database to another user of Adviser/Manager, they need to Save the file 

to their directory of choice and then “Open” their existing Master Database. 

To utilise your master database on their copy of Adviser/Manager they need to select File/Set 

Master File and then use the BROWSE option to select the appropriate directory where they saved 

your master database copy with a *.pm extension. When found, select the File name by clicking on it 

to highlight and then select “OPEN”. Your database will now be the default database for their copy 

of PA. To revert to your original database simply select the RESTORE DEFAULT option on the same 

page. 
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 

Exercise 4.1 
Adding and Deleting Master Database 
items  
 

Adding a new item 

1. “Open” the master database 

2. Select Herbicide in the Navigation tree. 

3. In the sub groups within Herbicide select Group-M Glycine 

4. Select the add button. A new row will appear at the base of the group M Table in the 

right pane. 

5. Add a new product called “no frills kill” herbicide (generic Glyphosate 450) and type in 

the details. 

6. You may wish to sort at this stage as the order in this table persists in the drop downs 

in the main program. To do this, select the sort button from the toolbar. 

Deleting an Item 

1. Deleting a product is very similar to adding, lets delete the product we just added; 

2. Select the product to delete “no frills kill” herbicide (generic Glyphosate 450) 

Chemicals-Herbicide-M Glycine- then the product 

3. Select the delete button on the top toolbar then “yes” from the drop down. Now 

minimise the herbicide section by selecting the minus button adjacent to herbicide. 

Excluding an Item 

1. Excluding items is just as easy by ticking the box adjacent to the item to be excluded; 

2. Select the item to be excluded then tick the box. Select fertilisers then tick the supplier 

companies that you do not deal with 

3. Select another item that you may never use and exclude it, select operations then tick 

a product. 

modifying an Item 

1. Modifying an item is just a matter of typing over the existing figures. Commonly rates 

per hectare, costs and expected yields and returns are areas that need to be checked. 

2. Select crops Broadleaf (Dicot) and change the yield and $/T value figures for canola. 

3. Select Chemicals-Herbicides-Achieve WG and change the cost and default application 

rate to $90 and .38. (380 grms)   

 

You can also PRINT your selections for Crops/Fertilisers/Chemicals and Operations by utilising the 

PRINT LISTS option, and if need be control this list via the EXCLUDE option within each sub heading 

group 
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Chapter 5 – Data Entry 
 

In ‘Chapter 3 – Navigation’, the concept of the Management Zone was introduced and was 
defined as a particular piece of land over a given timeframe. At this point we should revisit 
the Management Zone as it is at the core of all our input data entry. 

 

COMMON METHODS FOR ENTERING DATA 
Throughout the software the process for adding, editing or deleting records is consistent. The 

common buttons are as follows: 

 Add new record to bottom of table 

 

 Delete selected record 

 

 Shift record up one row (change sort order) 

 

 Shift record Down one row (change sort order) 

 

Copy plans to actuals 

   

 

 

Note that deleting a record is permanent with no undo function,  

however you are always prompted to prevent accidental data loss. 

 

 
 
 
 
 
 
 
 
 
 

There is an up to date master data base file available on the back 
paddock website www.backpaddock.com.au or by request via the help 
desk on 1800 557 166 7am-7pm EST or email 
support@backpaddock.com.au 

 

 

 

 

http://www.backpaddock.com.au/
mailto:support@backpaddock.com.au
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 Table Layout – Management Zone Table 
(Management Tab) 

 
Crop Type  Crop Type name from Master List 
Variety O Variety name from Master List 
$/T  Seed price in dollars per tonne 
Ha  Seeding area of this Management Zone 
Kg/ha  Seeding rate in kilos per ha 
Date O Seeding Date 
Pasture O Indicates pasture (necessary to allocate livestock paddocks) 
U/Sow O Indicates zone is under sown 
Blend O Indicates blended seed 
Grade O Indicates graded seed 
Irrigated O Indicates zone is irrigated 
Summer O Zone is a Summer crop 
Symbol O Footnote symbol used in reports 
Footnote O Notes for Zone. Also used as zone footnote in reports 

O = optional  

5.1 MANAGEMENT SECTION 
 

 

 

By default each paddock has a Management Zone defined for each year. This simplifies the data 

entry process considerably unless we wish to split a paddock into two or more Management Zones. 

As the Management Zone is usually defined by its crop type or rotation status it follows that this is 

the best place to start entering data. 

The crop type can be set either on the Management View or the Rotations View.  The Rotations 

section can be a good place to plan the whole-farm cropping program in one place without the 

distraction of inputs other than seed (Refer to Rotations section). 

MANAGEMENT ZONE DATA 
 

 

Primarily the data entered in the Management Zone table is the crop type and seeding rate 

information. Available data fields are summarised below.  
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In addition to these fields, buttons on the Management Zone toolbar provide access to other tables 

for data linked to the currently selected zone. 

BLEND 

Opens the seed blend dialog - This allows any number of seed varieties to be used on one zone. 

DRESS 

Opens the seed dressing dialog - This is used to apply any product to seed at a constant rate per 100 

kg of seed. Examples are seed fungicides, inoculants etc. Currently inoculant rates are calculated on 

the sowing rate of the main crop grown and not the undersown pasture, so in this situation enter 

the amount of inoculant required for the pasture seed per paddock 

PRODUCTION 

Opens the production dialog - Here you can enter grain production for the zone. Production can be 

entered in any number of loads and quality / price information recorded.  

IRRIGATION 

Opens the seed irrigation dialog - This section allows water costs and volumes to be attributed to 

zone. (This section currently under renovation/enhancement) 

FLAGS 

Selecting the flags tab exposes the check box flags that consist of pasture, u/sow, Blend, Grade, 

Irrigated, Summer, Hort. and Perm. Check the corresponding boxes to the relation of the paddock. 

When checking the Horticultural and Permanent boxes, new options then become available to edit 

data in.  

 

 

Share Farming  

Clicking on the share farming tab brings up the ‘Share Farming’ window where each paddock can be 

designated Share farming status. In this window you are able to adjust the percentage of income and 

costs that are attributed to the particular share farmer. Clicking on the Edit Share Farmers tab allows 

you to enter key associated notes about the particular share farmers. When a paddock has been 

designated as a share farm, then a symbol will appear in the navigational tree to indicate that the 

particular paddock is shared.  
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The share farming cost splitup can also be changed in the fertiliser and operations sections of each 

paddock although it defaults to the figures selected in the client options area if changes are not 

made. 

Note: To enable farm sharing you must first apply it in File>Client options 

PADDOCK NOTES 

The show paddock note from farm section is an important function as it displays the notes from the 

farm section in the management section and also in the report. It is useful in remembering key 

issues or points of interest within the selected paddock. The notes are displayed above the paddock 

name in the management tab and are displayed under the crop/variety section in the report for each 

paddock. 

Other functions on the Management Zone toolbar 

 

 

 Exposes paddock linking field in Management Zone table 

 Opens coverage map editor for zone (not included in Lite versions) 

 Displays paddock note from Farm View at top of Management Zone table 

 Opens Share Farming dialog 
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5.2 DATA TABS 
 

 

 

The data panes consist of 10 different sections that range from fertilisers to the rotation analyser. In 

these panes certain management adjustments and decisions can be made. 

Fertiliser 

 

 

 

Each of the following tabs in the fertiliser pane are shown below: 

 

 Moves Selected 

 Add  

 Remove / Delete 

 Copies plan data to actuals 

 Opens coverage map editor for application (not included in Lite versions) 

 Opens fertiliser history / nutrient audit dialog 

 Opens soil/plant tests dialog 

 Exposes fields in Fertiliser table that contain elemental analysis for fertiliser product 

 

Primarily the data entered in the Management Zone table is the crop type and seeding rate 

information. Available data fields are summarised below.  
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 
Take care when 
applying liquid 
fertilisers. Be sure 
that the price is $/T 
and the analysis is by 
volume. If the bulk 
density is not 
included for liquids 
then the summary 
totals may be wrong. 

 

 

 

 Table Layout – Fertiliser Table (Management Tab) 

 

Fertiliser  Fertilise name from Master List 

Cost ($/T)  Fertiliser cost in dollars per tonne 

Area  Fertiliser spreading area in ha 

Kg or l/ha  Application rate in tones per ha 

Elements × 12  Elemental analysis in % 

Timing O Timing description from Master List 

Date O Application date 

Liquid  Indicates the fertiliser is a liquid 

BD (t/m
3
)  If liquid then a Bulk Density is required here 

Share % O Percent cost contributed by share farmer 

Symbol O Footnote symbol used in reports 

Footnote O Notes for application. Also used as footnote in reports 

    O = optional  

 

Fertiliser History 

The fertiliser history section derives information from actual data rather than plan data. Once a 

fertiliser has been compiled in the plan section, clicking on the ‘actual’ button, will copy the data 

from the plan section to the actual section.  

* Without the data in the ‘Actual’ section the previous year’s fertiliser records will not be displayed 

when the fertiliser history window is displayed. 

The Fertiliser history button displays a new window that displays the paddocks fertiliser history over 

a selected period of time. To determine the number of years that are displayed for the paddock 

history, select the scroll down menu in the year’s section. From here you can determine how many 

years back you want to view the paddocks fertiliser history. 
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 

Exercise  
Adding Fertiliser  
 

 

Let’s add fertiliser to your paddocks. Your client file needs to be “Open” and select 

the ‘management’ tab; 

 

1. Select a paddock, click on the fertiliser tab then press the Add Record button for 

the Fertiliser table, and select a fertiliser from the Drop down arrow in the 

fertiliser column. Add a granular fertiliser such as DAP to be applied by a drill at 

seeding. Fertilisers can also be deleted in this manner using the delete button . 

Fertiliser can be sorted by using the up/down toggles located at the top left of 

each table. This sort order will be used in reports. 

2. Click on and complete the other cells to the right including cost, application rate, 

timing and sowing date. 

3. If you now select the ‘Elements” button above it will display just exactly what 

elements are being applied. 

4. Lets presume you need more nitrogen, again select the Add Record button  and 

select urea. Applied this product at 50kg/ha at growth stage 39 on 1/09/2006 by 

air. It is the same procedure if you were to add a fluid fertiliser, the only difference 

being you need to tick the liquid fertilise box so that the bulk density of the 

product is taken into account when analysing applied elements. 

5.  Fertilisers can also be deleted in this manner using the delete button . Fertiliser 

can be sorted by using the up/down toggles located at the top left of each table. 

This sort order will be used in reports. 

6. Fertiliser history and a nutrient audit can be viewed by selecting the history 

button. 

 

 

Once the number of years are determined the years will displayed in the left hand side column. The 

other columns consist of the crop grown in that particular year, the fertiliser applied during the year, 

the area applied, kg or l/ha, the date and the nutrients by kg/ha. To display the nutrient audit, simply 

check the box at the top of the screen. This will then display extra rows within the year 

that determine the removed nutrients per T/ha. To print the fertiliser history simply click on the 

print button located at the top left hand of the screen. 
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SPRAYS 

 

The spray pane contains three different sections that consist of the spray manager, mix and 

chemicals. 

Spray Manager 

The spray manager section allows you to adjust whether or not you want to view the chemical or 

adjuvant on the corresponding screen. This can simply be done by checking and un-checking the 

desired box.  

 

 

 

There are to view modes to choose from in the spray manger section that consists of the ‘edit view’ 

and the ‘summary view’.  

 

Each of these views are as their name suggests with the edit view enabling you to edit the sprays 

and the summary view providing you with an overall spray summary for the paddock. 

Whilst in the summary view you are also able to choose the specific details you want to display by 

checking or un-checking the boxes. Once you have your desired display you have the option to print 

the sheet by selecting the print button 

. 
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Sprays Mix 
 

Functions on the Sprays Mix toolbar 
 
 

 
 

    Move the selected mix up or down 
 

    Create a new mix 
 

    Delete the current Mix   
  

    Coverage Map 
 

    Show the spraying history 
 

    Copy Plans to Actual 
 

  Adjust the default water rate 
 

    Show/Hide Sprayed Area (defaults to 100%) 
 

   Concentrated Spray 

 

The default water rate can be adjusted to apply to each new mix by simply entering a new water 

rate figure in the provided section.  

 

The mix section determines the required water mix with the chemical/s for the particular paddock 

that is being sprayed.  

 

By ticking the Conc. Spray box, you are adjusting the spraying method to a concentrated spray, as 

used in horticulture, rather than a broad acre spraying method.  

 

A new column then appears which allows for the runoff rates to be calculated and included in to the 

spraying calculation.  
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 Table Layout –Mix Table (Sprays Tab) 

 

Mix  Displays the numbered mix 

Ha  The area to be sprayed 

Water L/ha  Water rate (default rate can be changed above) 

Water Req. L  Calculated water required 

Target Species o Lists the Targeted Species for the Chemical 

Timing  o Crop stage 

Date o Spraying date 

Notes o Additional notes 

Runoff L/ha O (Active when Conc. Spraying checked) 

    O = optional  

 

Chemicals/Adjuvants 

The chemical/Adjuvants section allows you to choose the particular chemical that is to be used on 

the particular paddock. This is done by simply clicking on the scroll down arrow (1) in the chemical 

space and choosing from the list the particular chemical desired (2). 

 

 

 

 

 

 

 

 

 

 

Chemical History 

The chemical history operates in the same respect as the fertiliser history. The same steps are 

required in order to display the number of years for the chemical history as in the fertiliser history.  

 

*Data must be ‘actual’ data and not ‘plan’ data to view chemical history 

The columns display the year, crop of the particular year, chemical class, group, type, chemical brand 

name, units, units/ha, area, date and the timing. 
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 

Exercise  
Adding Chemicals  
 

 

Lets add chemicals to your paddocks. Your client file needs to be “Open” and select 

the ‘management’ tab; 

 

1. Select a paddock, click on the sprays tab then press the Add ‘new mix’ button for the 

mix table, and select the specific water levels required, target species, timing, date 

and add any particular notes in relation to the chemical and paddock. To change the 

default water rate simply enter in the top of the pane. The mixes can also be deleted 

in this manner using the delete button . Mixes can be sorted by using the 

up/down toggles located at the top left of each table. This sort order will be used 

in reports. 

 

2. Once the mix is complied, it is time to add the chemicals to the mix. This is done in 

the chemical pane below the mix pane. 

 

3. Click on the ‘add chemical’ button and then click on the scroll down menu in the 

chemical column to choose a particular chemical.  

 

4. To add an adjuvant to the mix, click on the adjuvant tab located at the bottom of the 

screen. The same steps are then repeated as when adding a new chemical to the 

mix. 

 

5. Chemicals and Adjuvants can be deleted using the delete button . Chemicals and 

Adjuvants can be sorted by using the up/down toggles located at the top left of 

each table. This sort order will be used in reports. 

 

6. Chemical history can be seen in the history button located at the top of the pane. 

 

7. To view a summary of the particular chemicals being applied to the paddock, click 

on the summary tab in the view window to the left hand side of the chemicals pane.   

 

 

To print the chemical history simply click on the print button located at the top left of the window. 
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 Table Layout –Operations 

 

Operation   Choose the type of operation 

Details  Details you may wish to enter about the operation 

Area  The selected area 

Cost ($)  Calculated cost 

Timing o Stage of operation 

Date o Date of Operation 

Link type o Linked Activity to Operation 

Link Item  Linked items 

Share  Share percentage 

Symbol  Additional symbols 

Footnote  Additional footnotes to record 

    O = optional  

OPERATIONS 

The operations pane allows you to input the particular operations that will occur within the paddock 

at a particular point in time. In this section you are able to link particular operations to other 

activities. 

 

To insert a new operation into the program, click on the ‘insert new operation button’ and click on 

the scroll down menu in the operations column. 

Select a particular operation and the area and cost will appear automatically in the other columns 

deriving the information from the master database. Then select the appropriate timing, symbol and 

any other notes that can be included for the particular operation.   

Linking Operations 

To link a particular operation to a particular link type, simply click on the linking button at the top of 

the pane to display the linking column.    

With the linking column displayed, you are then able to select a particular link to the operation by 

using the scroll down menu in the ‘link type’ column.  
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Also the ‘Link item’ section appears which adds the option to include the possibility of different 

harvest units. This option is Not defaulted to grain so must be selected in certain circumstances  

 

To unlink the operation simply click on the link button again  

A common link type is “Harvest ($/Unit)” when linking a grain cartage cost to a yield say cartage of 

$20/T. In this situation the link item of “Grain” must also be selected. 

Importance of Operations 

It is important that the data entered in the operations section is accurate. All the data collected in 

the operations section is summarised and calculated in the gross margins section. Therefore it is 

important that the operation data is correct in terms of costs.  

The operations are also displayed in the cash flow, so it is important that the correct dates and 

figures are entered into the operations section so that they are displayed in the correct month in the 

cash flow projection table in the Adviser and Manager programs.  

SUMMARY 

 

The summary pane displays the summary of the operations and adjustments previously made in 

each individual paddock. It shows the cost, area and quantity of the particular variables over the 

year. Each of the particular summary drops down menu’s can be seen below. 

 

 

 

 

 

 

 

 

 

This particular menu determines the variables that will be displayed in the 

summary display. These variables consist of Crop, variety, fertilizer, 

chemicals, and operations.  

 

This particular menu determines the cost, quantity or area of the particular 

variable at a particular time. 

This menu determines what portion of the season will be displayed in the 

summary.  
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To display the summary over a monthly period, simply check the box that states ‘show months’  

 

The summary displayed can also be printed by simply clicking on the print button  

DIARY 

 

The diary pane allows for you to enter notes or data for particular dates in regards to the selected 

paddock. It also allows for you to enter rainfall figures in for each day of the year. 

There are three months displayed on the screen and can be scrolled through by pressing the arrow 

keys located next to the two months on the edges.  

 

To enter a specific diary entry on a particular date, simply click on the date on the calendar and then 

press the add note button which will then bring up a section to write a particular entry. 

 

To gain an overall summary of all the paddocks on the farm, click on the Farm Name or Block name 

in the navigation pane and then check the box ‘Summary Mode’ .  

This should bring up all of the notes and data over a period of time for each of the paddocks in the 

section below. To change the particular time frame of the Summary mode, click on the starting date 

and then click on the ‘From’ tab.   

This should change the date to the particular date currently selected on the calendar. Repeat the 

same steps as above to get the end date by selecting the end of the time frame on the calendar and 

then pressing the ‘To’ tab.  

To obtain a printed version of the summary, simply click on the print button located above the 

notes.  
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 Table Layout – Production (Price/Yields) 

 

Units  Select Unit type i.e.  onne sect  

Kg/Units  Determine the number of Kg per Unit 

Target Grade o The target grade for the current crop selected 

Pessimistic Price ($/t)  Estimated Price at a Pessimistic view  

Expected Price ($/t)  Expected price to receive  

High Price ($/t)  Estimated Price at a optimistic view  

Pessimistic yield (T/ha)  Estimated Yield at a Pessimistic view  

Expected yield (T/ha)  Expected Yield to receive  

High yield (T/ha)  Estimated Yield at a optimistic view 

Retain (T) o Amount of seed to retain from paddock 

Estimated Harvest Date o Estimated date of harvesting the particular paddock 

    O = optional  

PRODUCTION 

 

The production pane determines the expected prices and yields for the particular paddock 

highlighted in the navigation section. To view other paddocks prices and yields, scroll through the 

paddocks in the navigation pane. In this section you able to add additional harvest units like Wheat 

grain and straw ect. The default settings are set to grain but can be adjusted by selecting the 

products link or adding another production unit. 

 

At the bottom of the pane there is crop production forecast that includes the crop, variety and 

Grade. This displays the crop production forecast in tonnes by the three different perspectives, 

which include pessimistic, expected and high.  

 

The crop production forecast can be summarised by crop, variety and grade by selecting the various 

displays.  
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 Table Layout – General 

 

Opening Balance ($) 0 Opening Balance of the year 

Working Account Interest Rate (%) 0 Current financial interest rates 

Estimated months in debt 0 Months in debt estimate 

Quick budget Chemical costs ($/ha)  Quick overall Chemical costs budget 

    O = optional  

GROSS MARGINS 

 

The gross margins pane shows the gross margins of each individual paddock or over the whole farm 

depending on which is currently selected in the navigations pane. 

Gross margins can be viewed in “Plan” or “Actual” modes. When there are costs associated with a 

pasture/grazing paddock its best to select “Pasture Maintainence” in the production tab to explain 

the negative gross margin. In this situation income can be assigned to the livestock section. To 

include the depreciation and interest accumulated, simply check the corresponding boxes at the top 

of the pane. 

By checking the boxes for both the interest and depreciation, the accumulated interest and 

depreciation for the year are displayed in the gross margin. These contribute to the costs of the farm 

but are generally absent from the gross margins as they are commonly fixed costs.  

To Print the gross margins, simply click on the print button located at the top left of the pane. 

GENERAL 

 

In the General Pane financial data is recorded so it can be incorporated within the program and the 

report. There is also space available at the bottom of the pane to add additional notes for general 

comments on the particular year. These notes display at the start of the report. 
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WATER USE EFFICIENCY 

 

The water use efficiency pane calculates the total net water use efficiency of the particular paddock 

highlighted in the navigation pane by using the French & Shultz equation.  

The first step in this section is to set the water use efficiency crop parameters by clicking on the 

button in the top left of the pane. 

This will bring up an additional window where the crop parameters can be entered for reference in 

the calculation. 

A typical crop parameter layout can be seen in the following table below. The crop parameters are 

composed of the crops non-productive water (NPW) that consists of mm lost to evaporation, 

leaching, run-off etc during a normal year and a dry year. The harvest index represents the total 

percentage of the crop biomass extracted at harvest and the root index represents the total 

percentage of crop roots compared to entire crop. 

  

After the data has been recorded, return the main screen by pressing ok. At the main screen the 

Starting available Soil Moisture (SASM) and the Harvest available soil Moisture (HASM) can be 

entered in the blue figures. Entering the figures in the top sections can also set the default level.  
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Once these figures have been entered into the corresponding places, then the calculations are 

compiled and displayed below using the French & Shultz Equation. To distinguish the differences 

between dry conditions and normal conditions simply click on the scroll down menu above and 

select the appropriate one.  

 

*The total rainfall figures are calculated from the input of rain data into the rainfall section at the 

top 

 

ROTATION ANALYSER   

 

 

The Rotation analyser provides a range of analysis that is dependent on the type of rotation that has 

been established over the years on a particular paddock. The rotation analyser can display the 

rotations for a 3 to 10 year time period, which can be adjusted at the top of the pane. 

 

The default tillage, burn and removal factors can also be changed at the top of the pane by entering 

the figures in the spaces available. 

 

 

The Concept of Sustainability 

Sustainability is the goal of most modern businesses and it is increasing a much talked about 

concept. Sustainable agriculture is generally quoted to integrate three main goals - environmental 

health, economic profitability, and social and economic equity (Feenstra et al. 1997). Measurement, 

management and manipulation of sustainability has been an elusive concept for the farm 

practitioner due to the often-large number and complexity of the measurements required to 

produce a result from the more academic sustainability indices.  
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The Rotational Analyser  

The Rotation Analyser approach to sustainability management is proposed based on the premise 

that at the most simplistic level: sustainability of farming is a function of efficiency of use of the most 

limiting resource (generally water), soil health (a function of carbon input) and profitability (gross 

margin). Rotation Analyser requires input of a small number of commonly available paddock details 

such as total crop rainfall, crop yield and value, and variable costs. These inputs are used to calculate 

ratios such as:  

 Precipitation Use Efficiency – efficiency of conversion of rainfall into produce – using fallow 

plus in-crop rainfall received adjusts this ratio for the effectiveness of the enterprise owner 

in storing and extracting soil water. Decisions about tillage, weed control, nutrient use, 

sowing date etc all impact on this ratio. 

 Carbon Conversion Efficiency – efficiency of conversion of water into plant carbon to sustain 

soil health 

 $ Precipitation Use Efficiency – how effectively rainfall is turned into dollars 

 Carbon Efficiency Index – Greenhouse gas is an issue that is starting to impact on the farm 

sector. This ratio is derived from the soil carbon inputs and variable cost reflects the carbon 

returned to the soil per unit if carton consumed, using the assumption that most of the 

variable cost inputs are high carbon emitting during their production eg fertiliser and fuel. 

 Input Cost Efficiency – effectiveness of using variable cost (energy) inputs. 

 Economic Efficiency – efficiency with which economic resources (variable costs) are used. 

These ratios are then used to calculate and overall sustainability index to allow the comparison 

between rotation plan for a paddock or between paddocks. They also play a vital role in providing 

information about the strengths and weaknesses of individual crops in the rotation allowing 

tradeoffs between areas such as profit and soil health to be made with some knowledge about the 

scale and impact on the overall sustainability of the rotation.  
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Spray Recommendations 

The Recommendations tab is located in the Management Tab. Recommendations are "stand alone" 
and not linked directly to plan or actuals.  Once created and saved the paddock recommendation can 
be copied and saved as an “Actual Record” against the paddock(s) in that year. 

A recommendation report can include; 

 Single or multiple spray recommendations 

 Each recommendation can include any number of paddocks 
 

 

 
 
 
 
 

1. To Create a new Spray Recommendation click the   button.  A new 
Recommendation will be now be available in the Recommendation History panel. 
 
 

2. To Edit a Spray Recommendation click the   button.  This will open the Spray 
Recommendation Manager panel. 

             *When editing a Spray Reccomendation please note that it will be saved to the paddocks                                                                                                                 
added to the recommendation and not the paddock selected when created.  

 
 

3. To Delete a Spray Recommendation click the   button. 
 
 

4.  To Copy  from Plan to Actuals click the   button 
 
5. Enter a product name into the Filter by Product search box to locate the Spray 

Recommendation containing the product.  (Use this feature to quickly sort through multiple 
Recommendations and group them by product). 
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Spray Recommendation Manager 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

1. To Add another Mix to the Recommendation click the  button. 
 

2. To Delete a Mix from the Recommendation click the  button. 
 

3. To Sort through the Mixes on your Recommendation click the  buttons to move the    
mix up or down. 

 

4. To use available Arable Area versus boundary area  ensure box is 
ticked  

 Table Layout – Spray Recommendations 

 

Recommendations :  

 Create a new Spray Recommendation 

 
Open selected recommendation in the Spray 
Recommendation Manager panel. 

 Delete selected recommendation 

 Copy selected recommendation to Actuals 

 
Filter recommendations by Product Type 

Recommendation History :  

 
Enter Job Number for the recommendation 

 Date recommendation was Created 

 Date recommendation was Last Modified 

 
Add Advice type eg phone, office, on farm, field inspection 

 
Add Remarks eg with farmer/employee/owner 
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Recommendations Tab 

 

 

Add details to a Spray Recommendation 
 

1. To Add a Paddock to a Mix double click the blank space in the Paddock panel and a drop down 
box will appear.  Select the relevant paddock.  You can add as many paddocks to a mix as you 
like. 
 

2. To Add a Crop, Variety and Crop Stage double click the blank space and a drop down box will 
appear.  Select the relevant entry. 

 
3. To Add Conditions click the blank space next to Conditions to type a description e.g. actively 

growing, 3 days after last frost, calm 
 

4. To Add an Under sown crop or pasture double click the blank space in the Under sown panel 
and a drop down box will appear.  Select the relevant species. 

 
5. To Add a Droplet Size click the blank space in the Application panel and a drop down box will 

appear.  Select the relevant Droplet Size e.g. Fine, Fine/Med, Medium, Course, Very Course 
 

6. To Add a Timing click the blank space in the Application panel and a drop down box will appear.  
Select the relevant Timing. 
 
 

7. To Add a Product click the blank space in the Recommendation panel and a drop down box will 
appear.  Select the relevant paddock.  You can add as many paddocks to a mix as you like. 

       Once a product has been added, the following fields will be populated from the Master Data 
Base: 

Rainfast (hrs), WHP Grazing, Cutting, Harvest, Rate, Units, Reqd, Chemical Group and Active 
Constituent.  (You can change any of these figures by double left clicking the figure). 

8. To Add a Reason/Pest  click the blank space below and a drop down box will appear.  Select the 
relevant Reason/Pest . 

9. To Add a Growth Stage/Density click the blank space below and type relevant details e.g. GS 31, 
10/square metre 

10. To Add a Resistance Status click the blank space below and type relevant details. 
11. To Add a Comment click the blank space below and type relevant details. 

Table Layout – Recommendations Tab 
 

 Add Mix to recommendation 

 Delete Mix from recommendation 

 
Click arrows to Sort mixes 

 
Tick to use Arable Area if available 
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 Table Layout – Recommendations Tab 

 

Spray Recommendation Manager:  

 

Click drop down arrow to 
Add a paddock  

 

Click drop down arrow to 
Add Crop Type, Variety, 
Stage and Conditions 

 

Click drop down arrow to 
Add Undersown Crop 

 

Enter Application data 

 

Click drop down arrow to 
Add a Chemical 

 

Click drop down arrow to 
Add a Reason / Pest 

 

Type a Growth Stage / 
Density 

 
Displays Chemical Group 

 

Displays Active 
Constituent 

 
Type Resistance Status 

 Type Comments 
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 A large number of categories and items have been added to the Master data Base to enable quick 
functionality of most drop down boxes in the Spray Recommendation feature.  An up-to-date  
Master Data Base file is always available on the Back Paddock web site to download. 
 Users may find it easier to use the updated Master Data Base file and customise, rather than add all 
the new items so that the drop downs work smoothly. 

Report Tab 
 

 
 
 

The Report Tab allows you to Print or Save as PDF your Spray Recommendation.  By editing the tick 
boxes you are able to customise what appears in the report.  You can also add and change the 
position of a Logo and include a Spray Operator Recording Sheet with your report. 
 

1. To Print a report click the  button. 

2. To Save as PDF click the  button. 

3. To Email PDF click the  button. 

4. To toggle the various components of a report on or off, check/uncheck the relevant tick box. 

5. To Add or change a Logo in .bmp format click the  button.  To toggle a 
Logo on or off check /uncheck  the tick box. 

6. To change the position of the Logo click the  buttons.  (Note: clicking  will 
create a full page Logo). 

7. To Include Spray Operator Recording Sheet check /uncheck  the tick box. This form can only 
be completed as a hard copy. 

8. To Zoom in or out and Scroll through the pages of a report click the  buttons. 
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The Notes Editor 
 

 
 

The Notes Editor is used for adding notes, disclaimers and key codes etc. to your Spray 
Recommendation Report.  These notes will appear in the footer of all recommendation pages. 
It works like any other standard text editor allowing you to adjust the font, size, indent and spacing 
of the footer. 
 
A few examples are: 

 Whilst every care is taken in the preparation of these recommendations, I cannot accept 
responsibility for unsatisfactory results.  Many other factors beyond our control, either 
before, at, or after application, can affect the efficacy of the recommended treatment.  If in 
doubt that conditions may have changed since these recommendations were made, you 
should contact me.  Manufacturers instructions should ALWAYS be read before 
application.  Treating weeds larger than stated on the label is at the growers risk.  I accept 
no responsibility for off label/off permit application. 

 
 
 

Table Layout – Report Tab 
 

 

Print, Save or Email Spray 
Recommendation Report 

 

Tick box to include Components in Spray 
Recommendation Report 

 

Top boxes position Logo in Report 
Tick box to show Logo in Report 
Tick Folder  to select Logo (bmp or jpg) 

 

Tick box to include a Recording Sheet in 
Report 

 

Click magnifying glass to zoom in or out 
Click arrow to scroll through pages of 
Report 
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"READ THE LABEL BEFORE YOU BUY, USE PESTICIDES SAFELY".  ALWAYS READ AND FOLLOW 
PRODUCT LABEL ADVICE,  ESPECIALLY SPECIFIC APPLICATION INSTRUCTIONS.  CHECK THE 
STATUTORY BOX ON THE LABELS FOR "NO SPRAY ZONE" AND OTHER REQUIREMENTS.  
 

 
To the extent permitted by law I accept no responsibility to the Client and assumes no duty of care 
to the Client in providing this recommendation schedule to the Client and any use or non use by the 
Client of any statements, advice, information, recommendations or suggestions in this 
recommendation schedule.   
The Client accepts this recommendation report and uses it or does not use it at its own risk.  To the 
extent permitted by law accept no responsibility to and assumes no duty of care to any third party 
(being any person or legal entity other than the Client) in relation to this recommendation report.  
This recommendation schedule is provided to the Client only and to no one else and for no other 
purpose.  Any third party (being any legal entity other than the Client) uses or does not use and 
relies upon this recommendation report or any part thereof at its own risk. 
 

 Please carefully read the label information before commencing any treatment program.  
Whilst all care is taken in the provision of these recommendations, environmental, seasonal 
and other conditions can affect the performance of the treatment. Accordingly I will not be 
liable in any way for the failure of the treatment where seasonal conditions have changed 
since the date of this plan.  If chemicals are not used according to the label direction, you do 
so entirely at your own discretion and risk. 

 Water conditioners e.g. Liase, LI-700, Ammonium Sulphate 

 WETTABLE POWDERS 

 Granules e.g. Atrazine, Logran etc 

 Flowables e.g. Diuron & Simazine 

 EC formulations e.g. Trifluralin - these makes the water turn milky 

 Aqueous solutions e.g. Roundup, Sprayseed 

 SPRAY OILS THEN WETTERS E.G. BS1000, UPTAKE 

 Ensure that the tank is half full before you start adding chemicals. Ensure that agitation is 
operating before chemicals are added and allow each chemical to be thoroughly mixed 
before adding the chemical. Finally, add the wetter as late as possible to minimize foaming. 

 

Settings Tab 

 

 
 
The Settings Tab is used to adjust and enter default settings that are displayed in the Spray 
Recommendation Report.  It is used to alter the Font size and type, and various details that you 
would like displayed on reports.  
Please note client details are added outside the report in Tools/ Options/ Client Details. 
Using large font sizes can cause the report to display incorrectly, the table below outlines the default 
Setting if you need to reset.
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 Table Layout – Settings Tab 

 

 

Change Font size and type for 
various headings presented in the 
report. 

 

Add a title to reports and adjust 
Font size, type and position. 
*Please note: large Font sizes may 
cause reports to display incorrectly. 

 

Add Footer to reports and adjust 
Font size and type. 
*Please note: large Font sizes may 
cause reports to display incorrectly. 

 

Add Agronomist name and contact 
details. 

 

Add a border and adjust 
background colour to Notes 
section. 

 

Enter default information for 
emails and pdf. 

 

Edit the Job Number of Spray 
recommendation. 

 
Enter other details. 
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5.3 FARM SECTION 

 

As previously mentioned in Chapter 2 – Setting up the Farm, the farm section allows you to create, 

adjust and arrange the paddocks on the farm. This is done using the buttons below the Farm tab.  

 

Paddock Boundaries (not included in Lite versions) 
One of the major functions of the Farm Section is the ability to map out the specific paddock 

boundaries on a Geo-referenced Aerial Photo map. This tool is useful in determining specific land 

areas and a detailed outlay of the farm/s. To enter the map set-up simply click on the scroll down 

menu on the map set-up tab and select boundaries.   

  

This will then bring up the Advisor boundary tool where you are able to create and edit particular 

paddock boundaries.  

*The Steps involved to create paddock boundary maps can be seen in the Mapping section, 

Chapter – 6 

 Table Layout – Farm 

 

 
Move selected paddock up or down 

 
Create a new paddock 

 
Insert a new paddock above current selected 

 
Delete current paddock 

 
Print this page 

 
Arrange paddocks alphabetically (Can’t arrange back once done)  

 
Copy plans to actuals 

 
Displays rainfall sites column 

 
Quick entry mode for paddock entry 

 

Displays multi-farm options (Create, Delete, Rearrange farm blocks) 
 
 

 
Select a different Farm Block 

 
Displays the 'boundary editing' window. 
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5.4 ROTATIONS 

 
 

The Rotations View provides an alternative data presentation to the Management View as it can 

present up to 10 years of crop type / variety data at one time. This is useful when you need to see 

what has been grown in paddocks in previous years while planning rotations for the present and 

future years. 

Area Summary  
 

The Rotations View also has an area summary table that displays a tally of total area for different 

crop types and categories, corresponding to the years displayed in the rotation table. This can be 

useful when planning the balance of production or when for example percentages are required for 

the spread of Cereal, Broadleaf and pasture. 

 

 

 

There are a few options that allow the table to expand further that consist of adding varieties, sub-

totals and percentages. These options can be included in the table by checking the boxes above the 

table. 

 

 

The bottom table represents the paddocks and the corresponding crops to the particular year 

displayed at the top. To expand the columns and display the variety as well, double-click on the top 

of the column on the year or ‘Crop’. This should then expand the columns, displaying both the crop 

and variety of that year. 
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5.5 ANALYSIS 
 
 

The analysis section in advisor, analyses the Plan for the particular year displayed. Each paddock is 

displayed with an analysis of the crop, variety, price, production, yield, income, total costs, gross 

margins and cost percentage income. Each of these variables are taken form the ‘Management’ 

section of advisor where the data was entered earlier.  

There are a number of views that can be used to view the paddock analysis. The sort order section 

allows you to view the order of paddocks via their productiveness. The table can also be changed to 

view a pessimistic, expected or optimistic view of the production and prices of the year.  

By choosing between Ascending and Descending sort order and clicking on a particular  
 
column heading on the table, the layout will change to display the particular column in  
 
ascending/descending order in relation to the columns value. The Paddock field sort  
 
alternates between alphabetical and user defined when repeating the heading click.  
 

 

 Check this box to display income, total cost and gross margins in $/ha 

 Check this box to include a column displaying the interest for each 

paddock 

 Check this box to breakdown and display the costs in seed, dressing, 

fertilisers, chemicals, adjuvant and operations. 

 Use the scroll down menu to choose between an expected, 

pessimistic and high price received. 

 Use the scroll down menu to choose between an expected, 

pessimistic and high production levels. 

 Choose to display the bottom totals as an average or total and check 

the box to weight the averages by hectares. 
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Exporting Table 

The Gross margin table can be exported to another program for further analysis’s or display. This 

table can be displayed in such programs as excel or PDF etc. To export the table, click on the ‘copy 

table to clipboard’ button , which will allow you to then “Open” a different program and then 

select paste via the Edit>Paste function. 

5.6 RAINFALL 

 

The rainfall section allows you to record rainfall levels at any date of the year. This section is mainly 

displayed in yearly view with the months running across the top of the table and the dates running 

down the side of the table. The rainfall section also has a navigation window that allows you to 

quickly identify months and dates for future references.  

To add or choose between different rain gauges, use the functions at the top of the navigation 

window.  

 Click on this function to bring up a window to add new 

rain gauges and adjust there location by entering the 

Northing and Easting co-ordinates 

 Click on this function to import rainfall data from 

another specific source 

 Use this scroll down menu to choose between the 

different rain gauges on the farm 

 

Allocating Rainfall Gauges to Paddocks 

In order to designate specific rain gauges to various paddocks, the number of rain gauges must first 

be compiled in the rainfall section by clicking on the add button 

Once the number of rainfall gauges has been compiled, enter the main Farm tab at the top of the 

page where the paddock boundaries are created.  

Once in the Farm section simply click on the rainfall gauge button at the top of the window to 

display the rainfall gauge column. 
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The rain gauges can then be allocated to particular paddocks by selecting the scroll down menu in 

the column and selecting the appropriate rain gauge for the site. 

  

Rainfall views and Displays 

To change the view of the table, scroll down to the bottom of the navigation window and click on 

‘month’ or ‘year’ view to determine which view is most suited for the table.  

 

To display the rainfall chart with the current rainfall figures for the year, check box at the bottom of 

the navigation window to display the chart next to the rainfall table. The Deciles can also be 

displayed in the graph by checking the box underneath the rainfall chart box. 

 

The arrows located in the navigation window allow you to shuffle through the years in by 1 and 5 

lots. Clicking on the single arrow will change the calendar either forward or backwards a year and 

clicking on the double arrow will result in a leap of 5 years. Clicking on the ‘Today’ button will result 

in the calendar returning to the present day of the current year. 

 

 
Historical rainfall data is available from Back Paddock Software. Licenced users just need to phone 

the Help Desk on 1800 557 166 or email to support@backpaddock.com.au with their request.  

 

1. You must clearly nominate the nearest open Bureau of Meteorology (BOM) recording station to 

your farm – often post offices, research stations and some farms. Best to nominate, if known, 

the BOM station name or number. 

2. If not known then simply nominate nearest town with a backup town close by and the particular 

State. 

3. Data should then be emailed back to you via Back Paddock Software with instructions on how to 

down load the file.   

   

To import the downloaded historical rainfall data file into adviser, start in the rainfall section of the 

program and simply click on the ‘import’ button . This will bring up an additional window, where 

you are able to import the particular data from the saved location you designated when 

downloading the file by clicking on the “Open” button . 

 

 

mailto:support@backpaddock.com.au
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5.7 CASH FLOW (NOT INCLUDED IN LITE VERSIONS) 
 

  
 

The cash flow section displays the current year’s incomes and expenditures and calculates total 

expenditures, balance and Cash flow. This section derives its information from other parts of advisor 

and is mainly used as a reference to the cash flow over the months of the year.  

Note: Caution should be taken when interpreting this section. It is not meant to be a comprehensive 

cash flow.  

It is important that each of the income or expenditure aspects of the cash flow have a designated 

date in relevance to their activity date. The dates are designated in the corresponding sections in the 

management tab under particular panes, like the fertiliser and chemicals.  

Note:  Please be aware of the date source and do not confuse activity date and purchase date. 

 

 

 

 

 

Exporting Table 

The Cash Flow table can be exported to another program for further analysis’s or display. This table 

can be displayed in such programs as Excel, PDF or Word. To copy the table, click on the top left 

hand square and drag down to the bottom right hand square so that al the square are highlighted in 

blue. Then right mouse click and select ‘copy’ or follow the commands, Edit>Copy. Once in another 

program simply right mouse click on the empty screen and select paste or follow the commands, 

Edit>Paste. 

 
 
 
 
 
 
 

 The ‘No Date’ column can help determine which 

areas still have undesignated dates. If particular 

crop expenditure displays ‘No date’ then it could 

be in regards to an undesignated fertiliser used on 

the crop. 
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5.8 LIVESTOCK 
 

 

The livestock section allows for you to adjust the groups of livestock located on the farm and which 

paddock they are correlated too. The first section allows you to classify the specific stock group and 

then the later sections classify the stock class and then the related income and expenditure. 

Stock Groups 

The livestock section allows you to include livestock groups and classes into the program that are 

currently run on the farm. The first step in this section is to define the particular stock groups that 

are on the farm i.e. Sheep or Cattle. Click the add group button at the top of the window.  

*This section applies to all years. Yearly data is altered in the below sections (Mobs) 

This will then provide a scroll down menu in the type column that will allow you to choose the 

particular Group type on the Farm  

 

After you have determined the particular group type, you are able to give that group a particular 

group name (optional) and also add any particular notes. 

 

Define Mobs 

After the Group type is determined Mobs section is then available to further define the selected 

group type. Click on the add button to enter a new stock class for the group. 

Once you have added a stock class you are able to access the scroll down menu and choose a 

specific class for the group.  

 

 

 

Once the stock class has been entered a description, opening number, DSE/hd, Value ($/hd) and 
notes can be adjusted and entered along side the class. 
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There can be a number of stock classes added to a particular group that could consist of ewes and 

weaners or Steers and Heifers etc. 

*The particular year can be adjusted by selecting the arrows located above table 2.  

Once the stock classes have been identified in the group type, the costs, income, gross margins and 

Paddock allocation can be compiled at the bottom of the page. This section has the four sections 

displayed in tabs along the top part of the bottom pane. 

 

Costs 

The costs section indicates the particular costs associated with the current selected Mob. Using the 

scroll down menu you are able to choose from a list of costs and then determine the units, $/unit, 

units/hd, hd, date and notes that are associated with the particular cost. 

 

Income 

The income section indicates the particular income associated with the current selected Mob. Using 

the scroll down menu you are able to choose from a list of income types and determine the units, 

Low ($/units), Expected ($/units), High ($/units), low (units/hd), expected (units/hd), high (units/hd), 

hd, Date and Notes that are associated with the particular income type. 

 

 

Gross Margin 

The gross margin section provides an overview of the particular gross margins for the currently 

selected stock class. To include certain features like the interest, livestock capital costs and 

depreciation, simply check the boxes above the gross margin display. 
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Paddock Allocation 

The paddock allocation section allows you to allocate particular paddocks to the currently selected 

livestock. The current stock groups selected will be designated the paddock in the paddock 

allocation section. In the left hand window, a list of the farms and paddocks are  

displayed and can be expanded and retracted by selecting the plus/minus button next to the names.     

Once a particular paddock is selected, click on the add button which should then make the paddock 

appear in the paddock column. The area is displayed in the adjacent column and next to this column 

is a place to write notes corresponding to the particular paddock and livestock. 

All paddocks that are grazed, irrespective if pasture or crop, must be ticked in the Management zone 

under the flag section as a pasture otherwise stock will be unable to be allocated to that particular 

paddock. 

          

5.9 INVENTORY 

 

The inventory section allows you to adjust certain inventory items that are in possession of the farm. 

Ideally this section refers to the stored available chemicals that are on the farm. The inventory 

section also lists the people associated with the farm in terms of owners, employees, contractors 

etc. To add a new chemical, simply click on the add button located in the Products window. 

After clicking this button, a new inventory column will appear in the right hand side window that will 

allow you to select a particular chemical brand and lists information on the particular chemical. 

The main part in this section is to use the scroll down menu and select the particular chemical.  
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There is also a list of other information that is optional to enter for the particular chemical that 

consists of information like, purchase date, pack size, cost, notes etc.  

To add people in the inventory section, simply click on the people tab at the bottom of the left pane.  

 

 

This will bring up a new pane on the right hand side that allows you to add new people by selecting 

the add button and then entering information like their name, qualifications and notes in the 

designated areas. 
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5.10 REPORTS 

 

The Report section collectively acquires all the summaries and assumptions derived through the 

program and display them in report format for printing and viewing. This report is displayed as a 

‘Plan’ that is derived for a particular year and is used as a guide in making operational decisions 

throughout the year.  

Note: All prices stated in the report are GST exclusive and a guide only. 

There are a number of particular reports that can be displayed via the report library, located in the 

top left pane. These reports consist of the full report-general or general link mode, Share farming, 

livestock, chemical history, crop input, paddock report, spray program and wheat competitions. 

 

In each of these reports, there are different sections that are then displayed in the report navigator, 

below the report library. This Report navigator allows for quick access to the certain parts of the 

report, which are then displayed in the main window on the right. 
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To adjust the set-up of the main report that is displayed in the main window to the right, click on the 

set-up button located above the window. 

 

This then brings up the set-up window where adjustments to the report layout and display can be 

made. To include and exclude particular parts of the report simply check or uncheck the boxes in the 

left hand window.  

 

 

 

 

Adding Footer & Headings to Report  

To include footers & headings to the report, simply expand the Headers and Footers section by 

clicking on the expand button next to the name.   

With these sections expanded there are a number of other details that can be included into the 

report. These consist of: General notes, file name, farm name, logo, page numbers, date and 

prepared by. To adjust the settings of these particular aspects, simply click on a particular one and 

then an editing section should appear for some in the window to the right, complete the additions 

and select ok.  

Adding Logo (not included in Manager versions) 

To include a logo on the report in set-up expand Headers, select logo and browse for the particular 

file. Then select OK. The logo should be a bmp file and approximately 185 X 160 pixels. 

Paddock Order and Arrangement 

Paddock Pagination arranges the particular setup of the pages in the report. The option to group 

paddocks by Farm or crop type can be done through the scroll down menu. Other options consist of 

compiling the report so that each paddock is on a new page or is continuous; keeping paddocks 

together, thumb tags, subtotals and underling section headings.  
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Font adjustments to Report 

The report font and font size can also be adjusted at the bottom of the window by using the 

designated scroll down menus. 

 

 

In the main reports window, there are a number of tools associated with displaying the report on 

the screen or for printing purposes.  

 Refresh the current page 

 
Search the Report for a specific section 

 
Export report – save as a PDF, Word or Excel document 

 
Print Report 

 
Shuffle through Pages 

 
Page display – Page width / whole page / zoom 

Uses of the General Report 

The report is essentially the whole programs management decisions displayed in an easily 

referenced and formatted guide for users to clearly see objectives and decisions made within the 

program for future use. The report can be an extremely useful guide for rotation analysis and 

planning, investigating costs and expenditures, timetable of operations, submissions for finance, 

benchmarking and more.  

Rotation Summary 

The rotation summary of the report helps to clearly identify the paddocks rotations over the 

previous years. Helps to provide a guide for the current years rotation to be used and also to analyse 

next year’s crop rotation. 
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Area Summary 

The area summary of the report provides a whole farm overview of the total amount of crops 

currently grown. This can be useful in analysing output levels and planning sales and storage for the 

current year.  

 

Variables Summary 

In this particular section of the report, the variables are summarised for the current year. These 

variables consist of the fertiliser, chemicals and operations. Each of these variables are summarised 

by there particular product or operation, area allocated, average $/ha and total. These summaries 

help to identify all the variable costs associated with growing the particular crops for the current 

year. The cost by crop is displayed at the bottom of the summaries and displays the crops in 

association with their variable cost.  

 

Costs by Crop Table and Graph 

This section summarises the broad cost groups by crop type and is useful when planning farming 

requirements and identifying cost areas that could be re visited. The same information can be 

represented in a graphical form by selecting cost chart tab beneath the crop costs tab in reports set-

up.  

 

Gross Margin Summary by Crop 

This particular section of the report looks at the particular gross margins of the crops in relation to 

pessimistic, expected and optimistic prices and production levels. This section is ideal for identifying 

the potential gross margins per crop dependent on the type of season. This allows for an analysis of 

management decisions that can be initiated if the season is better or worse than expected. 

 

Paddock Summary 

The paddock summary section mainly displays the crop and the associated costs and operations that 

are devised for the year. This section is the main section of the report as it outlines each individual 

paddocks variables and their timing of application. This provides a useful guide for advisers and 

farmers and allows for them to analyse and plan operations and applications that are needed in each 

individual paddock. In the report set-up tab tick off the economic tabs and Paddock details input 

total tab and an operations report can be created and is useful for farm workers or contactors. 
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Actuals 

As mentioned in the previous chapters, the program operates between ‘Plans’ & ‘Actuals’. The plan 

section allows consultants and managers to plan certain events and operations prior to their 

execution. Plans are useful in determining the operations and costs that are associated  

for the farm in that year and provides an outline for others to operate from. Once the actual plan 

has been executed it can then be recorded as an ‘Actual’ event and noted in farm reports. 

The report can be changed between plans and actuals so that they display the current plan of 

operations for the year or the actual operations and procedures executed throughout the year.  
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Chapter 6 - Mapping (not included in Lite versions) 

 

INTRODUCTION TO MAPPING 
 

This chapter will provide you with a general overview of how to go about using Back Paddock 
Mapping, it outlines the basic steps involved in setting up a farm map in Back Paddock 
Software. After completing this chapter you will be able to: 
 

 Obtain an image of your farm 

 Load your farm image into Back Paddock Software 

 Add paddock boundaries (arable and non-arable) to your farm map 

 Add crop details to each paddock layer on your farm map  

 Customize the display of your farm map to show paddock names, areas, etc 
 

You will create a high standard map image of your farm that can be printed or emailed. See the 
below image for and example of what BPS mapping can do. 
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Back Paddock’s mapping can utilise an orthorectified (geometrically corrected so that distances 
shown are uniform and can be measured like a map) aerial photo with  
known control points. Once loaded Back Paddock formats the image combining the visual 
characteristics of a photograph with the geometric qualities of a map, geo- 
referencing the image and resulting in a spatially accurate image to scale with correct 
coordinates. This image eliminates distortions caused by camera angle and the altitude of 
landforms. The image is generally too large to email and is supplied on a CD and is usually a JPG 
or BMP file type. 
 
An aerial photo image is usually obtained by various aerial photo companies for a fee, these 
photos are high quality digital images with a very high level of accuracy, (see “Obtaining an 
aerial photo from a paid provider”). However there are free options that can be used to obtain 
an image of your farm, one of these options been Google Earth. 
 
Google Earth can be utilized to obtain an image of your farm along with the appropriate co-
ordinates. The process for obtaining an image from Google Earth is outlined in this user guide 
(see “Obtaining an aerial photo using Google Earth”), however for a digital image with improved 
quality and accuracy we recommend a paid aerial photo provider. 
 

OBTAINING AN AERIAL PHOTO FROM A PAID PROVIDER 

New South Wales 
 

NSW Department of Lands Ph 02 6332 8123, Fax 02 6332 8299 
Locate and purchase the image on the web at; http://www.lands.nsw.gov.au/airview/>Spatial 
search>select map>place your 
order>enter customer details>submit order>print order, complete payment details and in the 
special instructions space indicate that you require a “Digital image with control points” then fax to 
the number above. 
For accuracy and to avoid a spatial search on the web fax indicate the Parish, Lot and DP numbers of 
the property, which are usually on a Local Government rates notice and ask for a quote. 
Typical image prices range from $150-$400. 

Victoria 

 
Qasco VIC Image Ph 03 9682 3330, Fax 03 9682 3335 Email digital@qasco.com.au 
Firstly locate the property at Vic Land web site, 
http://www.land.vic.gov.au/land/lcnlc2.nsf/Home+Page/Land+Channel~Home+Page?  
open>Property reports>agree to terms and conditions>search for the property>print 
Then draw the property boundary on the printed map and fax the map, Parish, Lot and DP numbers 
to Qasco for a quote for a orthorectified image. Prices will range from $200-$800 

 

http://www.lands.nsw.gov.au/airview/
mailto:digital@qasco.com.au
http://www.land.vic.gov.au/land/lcnlc2.nsf/Home+Page/Land+Channel~Home+Page
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Western Australia 
 

Landgate offers orthorectified digital aerial photographic images at varying resolutions. These 
images cover a large portion of Western Australia. 
View, purchase and download images online at SkyView WA (just select this link) or log onto 
www.landgate.wa.gov.au/corporate.nsf > aerial imagery > aerial photography > orthorectified digital 
images > Skyview WA > Go. Print out the handy hints and follow the directions. 
SkyView WA displays digital aerial imagery for purchase on-line. Using SkyView WA you can find your 
area of interest on a map, view the imagery and then purchase on-line, all at the click of a mouse. 
You can order an ECW image on CD-ROM. ECW format is a more complex compression format 
regularly used by mapping professionals, which allows compression of very high-resolution 
(definition) imagery. ECW images are geo-referenced already. 
Contact details; Ph 08 9273 7555 or Email; sales@landgate.wa.gov.au 

South Australia, Queensland, Northern Territory and Tasmania 
 

Email support@backpaddock.com.au for each land title required; state the Parish, Lot and DP 
numbers which are usually stated on all rate notices. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.landgate.wa.gov.au/corporate.nsf
mailto:sales@landgate.wa.gov.au
mailto:support@backpaddock.com.au
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HOW TO ID A PROPERTY ON GOOGLE EARTH FOR A HIGH 
RESOLUTION IMAGE ORDER 
 

Please read the below instructions for details on how to ID a property on Google Earth for a high 
resolution image order. 
 

1. Enter the location of where the property is into the search box as shown below, for example 
we have used the town of Hillston in NSW. 
 

2. After entering the name click the  button to begin the search. 
 

3. The location entered in the search box will shortly be displayed on screen, see below. 
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4. Zoom in and find your farm area as shown below. Use the directional and zoom buttons to 
assist you, they have been circled in red in the below image. 
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5. Once your farm area is clearly visible on screen click the “Add Polygon” button circled in red 
below. 
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6. The New Polygon window is now displayed on screen, move the position of the New Polygon 
window so your farm is still visible. 

7. Enter the name of your farm in the Name box. 
8. Configure the Area Colour to be Outlined as shown below. 
9. Now you can draw around your farm image, leave some space outside of the property. 
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10. See below for an example of correctly drawing around the property. 
 

 
 

11. After drawing around the property click the OK button on the New Polygon window. 
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12. The name chosen in the New Polygon window will now appear in the Places panel as shown 
below. 
 

 
 

13. Right mouse click on the name and choose Save Place As. 
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14. Choose a name for the file and select where you would like to save it, see below. 
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15. Attach this file to an email message and send to wdate@backpaddock.com.au 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:wdate@backpaddock.com.au
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OBTAINING AN AERIAL PHOTO USING GOOGLE EARTH 

1. Start Google Earth and browse to your farms location. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Once your farm is clearly visible press the “Print Screen” button on your keyboard. 

3. Open Microsoft Paint by clicking on the Start Menu button, then navigating to All 

Programs>Accessories and selecting Paint from the list. 
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4. Once in paint press Ctrl + V on your keyboard. The image of your farm should now appear in 

the paint canvas. 
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5. Remove any unwanted area from your farm image and then select File>Save As. 

6. In the “Save As” window select where you wish to save the map image, then select the “Save 
as type:” down arrow and point to “JPEG (*.JPG;*JPEG;*.JPE;*.JFIF)”. Now click the *Save+ button.  
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7. Return to Google Earth and obtain co-ordinates for the map image. We have displayed the 
co-ordinates in UTM (Universal Transverse Mercator) and would recommend this as it is the most 
popular method for obtaining co-ordinates. To adjust Google Earth to display the co-ordinates in 
UTM navigate to the Tools menu and click Options. Ensure you are on the 3D View tab in Google 
Earth Options. Select the Universal Transverse Mercator radio button then press [Apply] and click 
[OK]. See below for an image of the configuration. 
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 In the below image we have selected two points on the map image and obtained the 
appropriate co-ordinates. 

 
Point 1 55 H 340203.30, 5991929.73 Point 2 55 H 339683.48, 5992439.16 

 
 

 Now we can load this map image into BPS and Geo-Reference it. 
 

 

8. Start the Back Paddock Software application.  
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9. Select the Mapping menu and browse to Tools then click Geo-reference image. 

 

10. The Adviser Geo-Reference Tool window appears. 
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11. Click the [Open Image File] button and browse to the location where you saved the map 

image. 

 

12. Select the map image file and press the [Open] button. 
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 The map image will now be loaded into the work space. 
 

 

13. Move the Point 1 and Point 2 icons to their correct place on the map image. For example left 

click the red + icon and drag it to move). 

 Now it is time to enter the co-ordinates for each point. 
 

 (Remove any alphabetical letters from the co-ordinate values when entering the co-
ordinates into Back Paddock Software).  

 

 For example for the co-ordinate value  you would enter 
it into the software as  
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14. After entering these points click the [Apply Reference] button. If the image does not appear 

to move then the Applied Reference has been successful. 

 If the image becomes distorted or disappears then the co-ordinates have been either 
incorrectly obtained or entered. Verify the co-ordinates and repeat this process. 

15. After successfully applying the reference click the [Create Geo-Referenced layer] button.  
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16. The “Save As” window appears as shown below. 

17. Specify a file name and location then press [Save]. 

 
 After clicking the [Save] button three files will be created in the specified location with the  
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extensions .bmp, .bpw and .tab. The .bmp file is the geo-referenced file that we will now 
use to draw our paddock boundaries on. 

CREATING A MAP PROJECT 
 After obtaining a Geo-Referenced photo we can create a map project and assign it as the 

current project in the software. 
 

 To create a Map Project follow the below process. 

1. Open the “Mapping” tab in the software. 

2. Click the “Open map layer from external file” * ] button under the “Layer Manager” 

Panel. 

3. Browse to the location of your Geo-referenced image, select it and press the [Open] button.  

 



 

Adviser / Manager User Guide - page 89 

 

 
 
 
 

 
 The image will now be displayed on the “Mapping” tab canvas.  

 

4. Click the “Map Projects” * + button under the “Layer Library” panel. See below. 

 
 
 
 
 
 
 
 
 

5. Now click the [Create New Map Project] button as circled in the below image. 
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 The “Save Map Project” popup box will now appear on screen.  

6. Enter a name for the map project and press [OK]. 

 A map project by this name will now appear in the Map Projects list as shown below. 
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 Now it is time to assign this project as the current project in the software.  

 
 
 

7. Open *Client Options+ from the “File menu”. 

8. In the Client File Options window ensure you are on the Configuration tab. 

9. Expand the Mapping option (click the [+] button) if required and click the [Background 

Project] heading. Use the down arrow button to navigate to the map project you have just created. 
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10. Select the project name and press *OK+ to close the “Client File Options” window 

 You have successfully set your new map project as the current project in the software. It is 
now time to create your paddock boundaries. 

CREATING PADDOCK BOUNDARIES 

1. Open the “Farm” tab in the software and click the *Map Setup+ button. 

2. Left click in the Boundary rectangular box for any paddock. The Adviser Boundary Tools 
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window is displayed. See below. 

 

 

In this window there are two main function tabs that consist of ‘Background’ and ‘Edit’. The 

background tab deals with the uploading of aerial maps onto the window for future reference. The 

edit tab deals with the creation, editing and deleting of paddock boundaries on the farm. The main 

tools on the menu consist of:  

In this window there are two main function tabs that consist of ‘Background’ and ‘Edit’. The 

background tab deals with the uploading of aerial maps onto the window for future reference. The 

edit tab deals with the creation, editing and deleting of paddock boundaries on the farm. The main 

tools on the menu consist of:  

 Select Tool – Selects a particular layer i.e. a particular paddock 

boundary 

 Mapping Drag tool – Select and hold to pan around map 

 Zooms to the maps full extent for all layers 

 Zooms to fit all selected shapes 

 Zooms to fit rectangle drawn by clicking, holding and dragging 

 Zooms specifically on location 

 

Background Tab 
 

The background tab is the first part to deal with in setting up the farms boundaries. If you have not 

created a Background Project then to bring up an aerial photo, click the “Open” file button.  

This will bring up an Open window where you are able to search files and folders to find your specific 

aerial photos. 

We are assuming you have created a Background project as described in the “Creating a Map 

Project” section and will continue on from this stage. 

3. Click the “Background Project” button. This will load the image we saved earlier as our 

background project to the Adviser Boundary Tools canvas. 
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4. Click the Edit tab in the Adviser Boundary Tools window as shown below. 

 

Edit Tab 
 

The edit tab allows you to create and edit paddock boundaries using the Geo-referenced Aerial 

photo uploaded in the background tab. 

In the edit tab section there should be the aerial photo that was uploaded in the background tab 

displayed in the window. From here you are able to create and edit paddock boundaries on the 

aerial photo. 

 

 
 

It may be helpful to increase the size of 
the window by clicking on the maximize 
button on the top right of the screen. 
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Create a new paddock boundary 

 
Edit an existing paddock boundary 

 
Delete current selected boundary 

 
Undo  

 
Redo  

 
 
The first step in creating a paddock boundary is to zoom in on the particular paddock to help identify 

the boundaries more clearly. It is important to note that it is not necessary for it to be precise at this 

stage as you are able to return to edit the boundary at a closer distance after the initial shape is 

compiled.   

 

 

 

 

 

 

 

 

 

Once the designated paddock is within the parameters of the window, the outlining of the paddock 

can be done by firstly selecting the ‘draw boundary’ button.  

5. Tick the Snap Nodes tick box and click the  tool. 

6. With this button selected you are able to start tracing around the paddock by clicking on 

points of the map. This draws a shape file around the paddock and highlights the paddock in yellow 

to identify the paddock area.  
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 Now we can draw our first paddock boundary. 
 
 
 

 

7. Left mouse click in each corner of the desired paddock to create a paddock boundary layer. 

See image below. 

 

8. To finish the layer unselect it by clicking the  button. 

9. Now reselect the layer by pressing the  button and clicking on the newly created 

layer. 
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The Auto Area section at the top of the window allows you to determine whether or not the 

paddocks area is calculated by the paddock boundary drawn on the aerial map. This section also 

allows you to adjust the amount of decimal places you wish the paddock to calculate in.   

 

 

10. A paddock name can now be assigned to this layer. You may type the appropriate paddock 

name into the “Paddock Name” text box or alternatively press the  button drop down 

arrow and select the appropriate paddock as shown in the below image. 

 

 
 
 
 
 
 

 

11. Complete this process for all paddocks then press the  button. After pressing the save 

button close the Adviser Boundary Tools window. 

The same process is used as before to create additional 

paddock boundaries. The only difference is that there are 

some additional tools that need to be recognized to help 

make creating additional paddocks easier.  

 

By checking this box the nodes of previously drawn 

paddock boundaries will appear as yellow squares. This 

allows you to identify the particular corners or joins in 

particular paddocks. 

 

 
 

Nodes= Nodes are the squares 

represented on the paddock 

boundaries. Each click when 

creating a paddock creates a 

node.  

Green Nodes - 

Represent the current selected 

paddocks nodes 

 

Yellow Nodes – Represent the 

nodes of other paddocks that 

are not selected 
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By checking this box the nodes on the current boundary being drawn will display a number in 

relevance to their order of creation. 

 

By checking the snapping box the snapping function is then incorporated into the creation of 

paddock boundaries. Ideally this means that when you are creating a new paddock that is adjacent 

to an existing paddock, clicking near the other paddocks nodes will create a node for the paddock 

being created on the same spot. This is mainly used for when paddocks share the same boundary. 

When two paddocks share the same boundary, using the snapping tool will snap the nodes directly 

to the neighbouring paddocks nodes. 

 

12.  

13.  

14.  

15.  

 

 Now we can setup the arable area layers. 

12. Return to the “Farm” tab in the software. 

13. Left click in the Arable rectangular box for any paddock in which a boundary layer was 

created. An icon will appear in the Boundary rectangular box as shown below if a layer has been 

created for that paddock. 

 
 

 After left clicking in the Arable rectangular box the Adviser Arable Area Tools window is 
displayed. 
 

 

By clicking near 

the two adjacent 

nodes, they are 

automatically 

snapped to them 
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14. Click the “Edit” tab in this window. Now select the layer as shown below, with the 

 tool. 

 
 We can now resize this layer to the Arable area size. 

15. Click the  button. This will now display corner dots on the layer.  
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16. Drag each corner to create the shape of the arable area. See the example below. 

 

17. Once the desired shape is created press the  button to save progress and close the 

Adviser Arable Area Tools window. 

18. Repeat this process to create all Arable Area layers. 
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Problems in Creating Paddocks  
 

Nodes Created from Wrong Boundary 
 
One of the main problems that can occur when creating a paddock boundary is the paddock shape 

distorting. This happens commonly when the paddock has a zigzag boundary shape or crosses over 

itself.  

 

 

 

 

When creating the paddock boundary from the bottom left corner of this particular shape, the 

boundary remains correct until it gets to the top left corner. From here, clicking on the right side of 

the boundary creates a node on the wrong boundary of the paddock. 

 

 

 

 

 

 

 

To create a node on the ride side of the paddock from the correct boundary, click and hold on the 

correct boundary and drag it across to the right side of the paddock. 

 

 

 

 

 

 

Wrong boundary 

Correct boundary 

Click & Drag 
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Another way to overcome this problem is to start creating the paddock boundaries at a different 

point of the paddock. 

 

 

 

 

 

 

Blue Nodes 
 
Blue nodes occur when the paddock has overlapped itself. They don’t appear when first creating the 

paddock but appear when you return to edit that paddock or select the paddock. When the paddock 

overlaps itself this generally is not a problem due to the fact that it may do so for a brief moment in 

time as the paddock is created. If there is a section that is left overlapped then the nodes that are 

affected will appear in blue. 

 

 

 

 

To delete the blue nodes, you need to delete the whole paddock and recreate the paddock again.  

The best solution to this problem is to insure that there are no inverted parts of the paddock when 

first creating the paddock. If there are, you are able to delete these nodes then, but are unable to 

delete them if you return at a later time. 

 

 

 

Start here 
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19. After creating all Boundary and Arable Areas, return to the “Mapping” Tab. 

 

The mapping section displays the whole farm aerial map with paddock boundaries and allows for the 

addition of other layers or adjustment of the map to create specific maps for personal use. Layers 

that can be introduced onto the map can consist of soil test sites that can display the nutrient and 

pH levels in the relevant spots tested. The map can also be adjusted to display crop type and 

varieties, which can be used for rotation planning. 

Layer Manager 

The layer manager is the where layers are imported, created and managed. Once a layer is created 

or imported they are displayed in the window display under the layer manager headings and tools. 

The layers position, properties and format can then be altered using the functions in the layer 

manager. 

 “Open” map or shape file from external file 

 Create a new map layer from data 

 Show paddock boundaries +  Show paddock Names  

 Reverse layer order for all layers 

 Move selected layer to the bottom/top 

 Move selected layer up/down the list 

 
Close selected layer 

 Close all layers 

 Set layer formatting and properties 

 
Set current layer transparency  
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Layer Library 

The layer library consists of four different sections that consist of saved layers, pre-defined layers, 

custom layers and map projects. These sections can be found at the bottom of the layer library 

screen:  

Saved layers 

The saved layers section allows for the current layers in the layer manager list to be saved onto the 

client folder. By saving the selection of layers, they can be retrieved at a later date. Select each 

individual layer and save them in the layer library to make them available for future use. 

 

 

  

 

 

 

 

Pre-defined layers 

The pre-defined layers represent the layers that have already been established in previous sections 

of the program. They consist of the paddock boundaries, arable area and non-arable area.  

 

 

 

By selecting one of these pre-defined layers and selecting the ‘retrieve button’   the layer is then 

displayed in the main window and is also displayed in the layer manager. With these layers then 

present in the layer manager, they are then able to have their properties adjusted via the formatting 

and properties button.  

 

 

 

 

 

 Save current selected layer to library 

 
Delete current selected layer to library 

 
Retrieve selected layer to Viewer window 

 Show column grouping 

 Click here to arrange layers according to name 

 Click here to arrange layers according to date  
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Custom layers 

The custom layers option allows for the creation of new customer layers to be added onto the map. 

Before creating a new layer it is best to distinguish the different functions on the custom layer 

toolbar. 

 

 

 

 

 

 

 

Nav Map 

The nav map section provides an easier guide to viewing the saved map projects. When selecting a 

saved map project, the load button will appear in the nav map menu.  

 

When loading a saved map onto the navigation map, the paddock boundaries will appear in the 

window below. The viewed area is highlighted in a light red square, which adjust to the zoom level in 

the main window. 

 

 

 

 

 

 

The tools in the Nav Map section consist of: 

 Loads the background project 

 Loads saved map project to Nav Map  

 
Adds a layer from layer manager 

 
Deletes current layers in the nav window 

 

 Custom layer grouping 

 
Create a new custom layer 

 Edit selected custom layer 

 Import vector layer from external file 

 Delete current selected custom layer 

 Add selected custom layer to viewer 
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Main Mapping Window 

The main mapping window displays all the current layers in layer manager window. This window is 

the final display that will be shown when printed either individually or with the report. There are a 

number of tools at the top of the window which consists of: 

 

 Prints map.  Accesses quick print selection or printing setup  

 Use printer ratio 

 Select Mode (Currently selected layer only) 

 Select Mode (all layers) 

 Mapping drag mode 

 
Zooms to full extent of all layers 

 Zooms to maps full extent for current layers 

 Zooms to particular shape/paddock/layer 

 
Zooms on point of mouse 

 Mapping zoom to drawn rectangle 

 
Set map viewer options 

 Show Map scale in viewer 

 Display layer library window 

 Display map legend window 

 Display nav map window 

 Display vector layer attributes window 

 Displays the current Easting’s and Northing’s on map 

 Displays current selected paddocks area 

 Legend Window 

The legend window displays the current layers within the layer manager. These particular layers can 

be expanded and retracted to display the particular colour key data relating to that layer. This is 

done by clicking on expand and retract button located to the left of the layer name. 
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For the colour code to be displayed once the layer is expanded you must ensure that the ‘Show in 

Legend’ Box is checked in the properties section in the polygon tab.   

This will display a triangle in the legend under the layer name with the matching colour found on the 

main mapping window.  

To change the name of the main heading for a particular layer in the legend window, click on the 

desired layer in the ‘Layer manager’ window and then enter the properties section . Once in the 

vector layer properties section, the layer tab should already be displayed where you can change the 

name displayed in the layer manager and the Name displayed in the legend.  

20. Load the Map Project to the canvas if required. This can be done by clicking the map project 

name and then pressing the “Load Selected Map Project to Viewer (add existing layers in viewer)” 

button. See the below example. 

 

21. After loading the map project to the canvas 

paddock boundaries can be displayed. To do this press the 

“Show Boundaries” * + button under the “Layer 

Manager” panel. 

22. To show paddock names on their appropriate layer 

click the down arrow beside the “Show Boundaries” button 

and click the Show Paddock Names option. 
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 The farm image should now show Paddock Boundaries and Paddock Names as shown 
below. 

23. To show our arable area click the  under the Layer Library panel. This will now display the 

Pre-Defined Layers options. Left mouse click “Arable Area” in this list then click the “Retrieve 

Selected Saved Layer to Viewer” button as shown below. 
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 Arable area layers will now be displayed on the map image as shown below. 

 

24. To view non-arable areas on the map image left mouse click “Non-Arable Area” in the Pre-

Defined Layers list then click the “Retrieve Selected Saved Layer to Viewer” button as shown below. 
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 Non-Arable areas will now be shown on the map. See example below. 
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DISPLAYING PADDOCK AREAS ON THE MAP 
 

 To display paddock areas on the map we will need a second paddock boundaries layer 
active.  
 

1. To activate a second paddock boundaries layer click the Paddock Boundaries option in the 

Pre-Defined Layers list then click the “Retrieve Selected Saved Layer to Viewer” button as shown 

below. 

 
 

 A second paddock boundaries layer named Paddock Boundaries(1) will now appear in the 
Layer Manager panel. 

 

 
 

2. Left click this layer then click the “Set layer formatting and properties” * ] button. 
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 The Vector Layer Properties window will now appear as shown below. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3. Click the Labels tab in this window. 

 

4. On the Labels tab select the Area option from the Label Field: drop down arrow. 

5. Select where you would like to position the paddock areas on the layers by populating the 

appropriate radio button under the Label Position heading. (Note if the paddock area and paddock 

names appear to overlap on the layer or the paddock areas do not appear on the layer then 

configure this option). 
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6. After selecting the desired Label Position apply the changes with the [Apply] 

button then click the [OK] button to close the Vector Layer Properties window.  

 

 
 

 Paddock Areas will now be displayed on the map image as shown 

below. 
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ADDING DATA TO A LAYER 
 

 Various different forms of data can be represented on your map image. In this example we 
will run through the process of adding crop data to a layer. 

1. To begin this process, select the arable area layer in the Layer Manager panel. Now click on 

the paddock layer that you wish to add the crop data to. 

 

2. After selecting the paddock layer click the “Create new map layer from data” * ] button, 

located on the Layer Manager panel. 
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 The Select Data for Layer window is now displayed. 

3. Navigate in the tree view to the desired crop, select and then click the [Next] button. (Note: 

you may specify the year in which to obtain the data and whether it is from the Plan or Actuals). 

 

4. After clicking [Next] the Appearance & Rendering window is displayed as shown below. You 

may specify the colour settings and style of the crop layer in this window. 

 

5. After populating the desired settings click the [Finish] button to close the Appearance & 

Rendering window. 
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 A new layer is created with the appropriate crop data and displayed on the map image as 
shown below. 

 

6. Follow this process to add all required data layers to your map image. 

7. Once all layers are created we will need to save them to your map project. To save these 

layers to your map project follow the below process. 

8. Ensure all layers are open in the “Layer Manager” panel. 

9. Click the “Map Projects” * + button under the “Layer Library” panel. 
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10. Now click the [Create New Map Project] button as circled in the below image. 

  
 

 The “Save Map Project” popup box will appear on screen.  

11. Enter the name of the map project you created earlier, or specify a new one if required then 

click [OK]. 

 

12. If you specified the map project that you created earlier then you will be presented with the 

following pop up box. 

 

13. Click the “Yes” button to overwrite the existing project. 

 Your map project is now updated with the currently open data. 
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PRINTING YOUR MAP IMAGE 
 

 After adding the desired layers to your map it can now be printed. To print your farm map 
follow the process below. 

1. Before printing your map you may wish to display the map scale. To do this click the  

button under the “Mapping” tab. 

 The Map scale is now displayed on the canvas. 
 

 

2. Click the “Print Map”  button. 

 

 

 

 



 

Adviser / Manager User Guide - page 119 

 

 The Print Preview screen is displayed. 
 

 
 

3. Verify the map image is displayed correctly on the page. If you would like to change the page 

orientation or size click the [Setup] button and configure the desired options. 

4. When satisfied with the layout of the map image click the [Print] button. 
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Chapter 7 - Productivity Features 

7.1 COPYING DATA BETWEEN PADDOCKS  
Data entered in any Management Zone can be re-used elsewhere in the Client File by use of the 

Copy Wizard. To “Open” the Copy Wizard, Select the Management Zone that contains the source 

data you wish to reuse and then select the Copy Wizard button from the main toolbar or menu [Edit 

> Copy Data]. 

This brings up the Copy paddock data window which allows you to select when and where you want 

the data to be copied too. 

The first step is to select the particular year you want that data to be copied too. By default the copy 

paddock data window remains in the current year as where the data was selected. To change the 

year simply select the scroll down menu in the destination year space and choose a particular year 

to copy too.  

The next step is to decide the source of data to copy. There are three sources to choose that consist 

of copying currently selected paddock, copying append selected fertiliser or scenario manager.  

 

 

The source data can be copied to any other Management Zone in any year. If you do not want all 

input data copied you can deselect items in the top-right corner.  

 

 

 

The data being copied can also be chosen to overwrite the existing data in other paddocks or to 

append to existing data. 
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Overwrite Existing Data 

The ‘overwrite existing data’ when copying function essentially means that the data being copied 

across will delete the current data in the data destination. For example copying fertiliser data across 

from one source to another will cause all the existing fertiliser data in the destination area to be 

overwritten by the copied data.  

Append to Existing Data 

The ‘Append to existing Data’ when copying function essentially means that the data being copied 

will merge with the existing data at the destination area. For example copying fertiliser data from 

one paddock to another will merge the copied fertiliser data with the fertiliser in the destination 

paddock. This feature can also be used when copying a spray mix as both the chemicals and 

adjuvants will be copied. 

Data Destination 

Destination Management Zones are selected with the mouse in the Destination Table at the bottom 

of the Copy Wizard.  

Multiple destinations can be selected by either holding the Control Key [Ctrl] while selecting with the 

mouse, or by dragging the mouse through the rows of destination Management Zones. Selected 

zones are shaded. 

Once the destination zones are set then press the Copy button at the top of the Copy Wizard. A 

completion box notifies you that the operation is complete. Close the box to return to the 

Management View. 

Uses and Benefits 

 Copies existing data from any area to one or more other areas 

 Major time saver 

 Avoid repeating existing data 

 Plan by crop type or Livestock Management Units rather than paddock 

 Use data from previous years 
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7.2 SCENARIOS (NOT INCLUDED IN MANAGER VERSIONS) 
 
Scenarios are used to copy the data of a common paddock setup and apply to other paddocks. 

Ideally this means that for a selected paddock, a scenario can be derived and then applied to similar 

paddocks that would require the same inputs. A crop type scenario is basically a standard recipe of 

inputs for a particular situation or district. 

Its important to include all the fine detail in the scenario so that minimal adjustments are required 

when copied to a particular paddock. Include dates, seed dressings, costs, timings, forecast 

yield/prices, fertiliser, chemicals, adjuvants and operations. 

Once an initial paddock setup has been compiled for a particular crop with variables, i.e. seed, 

fertiliser, chemicals, operations, timing etc, then this paddocks scenario can be copied and applied to 

other paddocks.  

The scenarios once saved are then displayed in the navigation window of the management section. 

The can then be selected at a later date and loaded again to apply to paddocks in future years to 

help save time by eradicating the similar data entries that were created in the scenario. Save the 

scenario by crop type name and date as the scenario drop down screen is sorted in alphabetical 

order. E.G. Wheat pre em 012007 

Creating Scenarios 

To create a scenario from the currently selected paddock, select the paddock in the management 

section and then follow the command [Tools > Scenarios > Load selected paddock to Scenario] 

or click on the up arrow icon in the scenario section.  This will then create a scenario 

based on the selected paddocks variables.  

View Current scenario 

To view the scenario, follow the command [Tools > Scenarios > View selected Scenario] or click 

on the icon adjacent to the scenario crop cell. This will then display a window that has all 

the particular aspects that the current scenario will add to a particular paddock. 

Load Selected Scenario 

To add a particular scenario to a paddock follow the command [Tools > Scenarios > Add scenario 

to selected Paddock] or click on the selected scenario in the scenario cell then select the 

down arrow in the scenario section. This will then add the current scenario to the current 

selected paddock. 
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Scenario Setup 

To save, “Open” or adjust a scenario simply follow the command [Tools > Scenarios > Scenario 

Setup] or click.   

Editing a Scenario 

To edit a scenario simply click on Tools > Scenario > Scenario Setup. This will open a window where 

you the can either click on the File Symbol    or follow the links by clicking on File > 

Open/Edit Scenario File. 

 

You are then presented with a directory search where you can then locate the particular scenario 

you wish to edit or open. After clicking on the particular scenario, the file will then be opened and 

displayed in advisor as a typical client file. 

A new tab will appear along the top of the window where you can switch between the farm setup to 

the scenario’s.  

 

In the scenario tab you are able to select and change any of the management options or variables to 

match a particular scenario. Crops can be copied from the scenario section and applied to the 

current management section in the Farm’s tab. 

 Scenario File 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 There is an up to date Scenario file available consisting of over 65 different 

crop types/scenarios both agronomic and horticulture available on the 

back paddock website www.backpaddock.com.au or by request via the 

help desk on 1800 557 166 7am-7pm EST or email 

support@backpaddock.com.au  

 

 

 

http://www.backpaddock.com.au/
mailto:support@backpaddock.com.au
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7.3 PADDOCK LINKING  
 

Paddock linking gives you the ability to dynamically link paddocks to other paddocks. 

This can be used as an alternative to copying data and to produce smaller reports for large farms. 

To link a paddock 

1. Designate a paddock as a Master (no action needed)  

2. Select a paddock that you want to link to the Master paddock  

3. Select the Link Button  in the Crop Section. This will expose a cell where a drop-down list 

of other paddocks appears  

4. Select Master paddock from list  

Repeat for as many paddocks as you want linked to master. Once linked only the area can be 

changed. All changes must be made in Master paddock and are automatically reflected in 

linked paddocks.  

To unlink a paddock 

Select the linking cell and press the Delete key on keyboard. If you want a linked report (One 

page for all linked paddocks), select Link Mode report from list on Reports Section. Link status 

can be easily viewed by selecting the Link-Node Navigation option in the Navigation Pane. 
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7.4 FIND & REPLACE  
 
The Find and Replace feature was included initially to allow a quick means of changing prices, rates 

or products for a particular season after a plan has been completed. 

The feature is now also being used as a review tool with users finding it a fast and thorough means 

of checking the plan before producing the Report. 

The Find & Replace function is accessed by selecting the Find/Replace  Button or from Menu [Edit 

> Find > Replace]. 

 

The Find & Replace Box will “Open” in the current year and mode (Plan or Actual). The navigation 

tree on the left of the box contains all inputs for that year and mode. Inputs selected in the 

Navigation Tree are summarised in the Table below. 

 

 

 

You can browse inputs at a generic or specific level. For example selecting Fertilisers will show all 

fertilisers in all paddocks for that year. Selecting just Urea will show only where Urea was applied. 

Similarly, chemicals can be summarised by type, group or chemical. 

 

 

 

Once a specific input is selected, the replacement tools on the right become active. You can select to 

change the input, the application rate or the price for the selected input. By selecting specific 

paddocks in the lower table, you can chose to only change rates in specific paddocks or opt to 

change all occurrences in that years plan. 
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 
Find & Replace as a review Tool 
 
Many users have found that the Find & Replace function is a good place to quickly check the 

plan. 

For example you can quickly create a summary of all the instances of a particular chemical in 

all paddocks and run your eye down the rates to see if your eyebrows rise at an unexpected 

rate. 

You can also check that all instances of a particular product have been priced at the correct 

level. 

If herbicide resistance issues are to be considered you can view products by chemical groups 

to quickly see where you are applying them and at what rate. 

 

 

 

 

Due to the fact that chemical prices can vary over the season, you are able to adjust the chemical 

discount/premium as a percentage change which can then be applied by selecting the [Apply to ALL 

in Table] button. This then adjusts the particular chemical price for all sections of the program.  

 
 
 

The [Replace Selections with] feature allows you to adjust the particular data with a replacement 

item. An example of this could be a particular chemical with a different chemical. You are able to 

also adjust the rates and costs. 

  

 

 

 

 

 

Examples of when this feature can be useful are: 

 Changing a price when price has changed in period between initial plan and printing report. 

 Changing rates as you fine-tune the plan. 
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 Changing products because availability or seasonal conditions change. 

 Changing crop varieties 

 Reviewing the Plan 

 

 

7.5 OPTIONS 
The options menu window is found by following the command [Tools > Options]. In the options 

window you are able to adjust the general settings, rotational settings, default values and mapping. 

General Tab 

The general settings section allows you to adjust the file preferences and general preferences of the 

program. The default settings for the folder options can be adjusted by selecting the file path and 

then clicking on the choose file path button located to the right.  

The general settings allow you to choose to display certain aspects of the program. By selecting true 

or false certain aspects will be displayed or not displayed. For example you are able to turn off the 

start up screen by selecting false in the corresponding area. 

 

 

To show the paddock area in the management navigation tree select 'true' adjacent to the show 

area tab. 

Rotations Tab 

The rotations tab allows you to adjust the settings of the rotation displays within the program. The 

two aspects of the rotations section that can be changed in the program consist of how many years’ 

rotations you want displayed and the current year’s column position when displayed. The drop down 

menus next to each can change either of these aspects. 

Default Values tab 

The default values for new data that is entered into the program can be changed via the default 

values tab. Default values for Seasonal Finance %PA can be changed in the space provided as well as 

number of months seasonal finance estimate (months per year). The last aspect in the default values 

tab that can be changed is the actual growing season from one designated month to another. 
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Mapping tab  

The mapping tab makes adjustments to the mapping section of the program. There are four areas 

that can be adjusted for personal preference that consist of the Map viewer, 

Area selection, Map scale and GPS settings. Each of the areas has particular aspects that can be 

changed by using the scroll down menus next to the default values. 

7.6 CHANGING THE THEME 
 

The theme of the program can be changed to better suit personal preferences. This works in the 

same regards as changing the windows themes on your computer settings by adjusting the colours 

and display of the windows. 

Clicking on the tools section on the top menu and scrolling down and selecting ‘themes’ can do this. 

This will then display the different themes available to be used within advisor. By selecting a theme, 

the display windows in advisor will change accordingly. 

 

7.7 SYNCHRONISE FILES 
 

Files within all Back Paddock Software products can be synchronised / merged. This feature is often 

used when the Adviser user creates a plan then emails the file to a Manager user which then 

updates and adjusts throughout the season, especially the “Actuals” data. Then this file is emailed 

back to the Adviser user who then merges the two to update the file with accurate records. Select 

file>Synchronise/Merge Client Files to open this feature. 
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To merge, the required file must be open then browse to select the updated files, select the sections 

to merge then select the Merge button. Data can be ammended or over written as desired. 

Additional paddocks or farms will also be added. 

 

To merge, the required file must be open then browse to select the updated files, select the sections 

to merge then select the Merge button. Data can be ammended or over written as desired. 

Additional paddocks or farms will also be added. 
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7.8 COPY PLAN TO ACTUALS 
 

Once the Plan is created the data can then be copied to Actuals and adjusted as details  

change such at inputs, rates, prices or timings. Whole sections can be copied across to actuals  

by the selection of the Plan to Actuals button which is located in the Fertiliser, Sprays and  

Operations sections.    

Alternatively the entire plan can be copied to actuals. Open the client file then 

 select  Tools>Copy plan to actuals>yes . Even if the records are not adjusted in Actuals this process 
is useful to ensure there is history to view at a later date. 

  

 

 

 

 

Chapter 8 – Trouble Shooting 

8.1 SELECTING THE MASTER DATABASE  
When trying to edit any detail in a file a “Master Database File Not Found” error occurs. 
 

 
 
The reasons this would occur are: 

 

o The master database has been moved from location set in Adviser. 

o The master database has been deleted from hard drive. 

o The set master database location is incorrect. 

 

By default the Master Database File should be located in My Documents>Back Paddock 

Software>Adviser>Master Data 
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To solve this problem, follow these steps: 

 

1. Start Adviser and click [Tools] then [Options]. 

2. Click the text that says “Current Master Data File”. A button will appear on the right. Click 

the button *…+ that appears on the right. 

3. Locate and select the master database file (*.pm) and click [Open]. 

4. Click [Apply] and [Ok]. 

 

 

 

 

 

 

 

 

 

 

 

8.2 ERROR WHEN TRYING TO UPDATE THE SOFTWARE 
 
When checking for update using the *Help+ *Check for Updates+ function Adviser presents “An error 

occurred while trying to locate the update to Adviser”. 
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The reasons for this occurring are usually because you are using firewall software such as Zone 

Alarm or is behind a corporate firewall that does not allow Adviser to communicate with the update 

server.  A firewall is a protection wall to stop unwanted downloads from the Internet.  

 

This can be fixed by following the steps below. NOTE: If you work for a large company and do not 

have Administrator Privileges, you need to contact your IT department and have received sufficient 

rights assigned to you by them first. 

 

1. Download the ‘Full Installer’ for Adviser from the website 

http://www.backpaddock.com.au/Downloads/AdviserFull/BPSAdviserInstall.exe 

2. Follow the install process that automatically runs 

  

IMPORTANT: 

 If prompted select OPEN or Run from current location DO NOT select “Save to Disk” as it is an 

Internet installation. 

  

If the download stops for any reason, repeat the process and it should pick up where it left off. 

 

8.3 SET THE SCENARIO FILE (NOT INCLUDED IN MANAGER VERSIONS)  

 
This error occurs either, when attempting to save a scenario to the scenario manager Adviser 

generates a Runtime error. Or, when attempting to start Adviser the following error occurs. 

 

 

The reason for this is because the Scenario file has been moved or deleted or is not set correctly. 

 

This can be fixed by following the steps below: 

 

http://www.backpaddock.com.au/Downloads/AdviserFull/BPSAdviserInstall.exe
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1. Click [Tools] then [Scenario Manager] then [Scenario Setup] 

2. Click [Browse] and locate scenarios file (*.SCEN or in some situations *.ADV) 

3. Then click [Open] and finally click [OK] 

 

By default the Scenarios File should be located in My Documents>Back Paddock 

Software>Adviser>Scenarios 

 

If this does not solve the problem then it could be that there is a problem with the licence.  In that 

case you need to contact us on 1800 557 166 or email support@backpaddock.com.au to get a 

replacement licence sent out.  

 

NOTE: Manager and Manager Lite products do not have Scenario Manager functions.  

 

 

 

 

 

 

 

 

 

8.4 THE “BACK PADDOCK SOFTWARE DEMO” WINDOW  

APPEARS ON START-UP 
 

The computer screen looks like: 

 

mailto:support@backpaddock.com.au


 

Adviser / Manager User Guide - page 134 

 

You may see this when: 

1. The licence file has not been installed correctly 

2. The computer has the incorrect date and time set 

3. The licence file is invalid. 

These are all easily solved.  Follow the steps for each error: 

1. The licence file has not been installed correctly 

a. Save the ‘Adviser.Lic’ file into Adviser’s install directory, overwriting any existing file 

(C:\PROGRAM FILES\BACK PADDOCK SOFTWARE\ADVISER) 

2. The computer has the incorrect date and time set 

a. Make sure the system date and time is correctly set by: 

i. Go to START at the bottom left corner of your screen 

ii. Click on Control Panel 

iii. Click on Settings 

iv. Click on Date & Time 

v. Adjust settings accordingly  

vi. Finally click [Apply] then [OK] 

3. The licence file is invalid 

a. Phone the BPS sales and help desk on 1800 557 166 or email 

support@backpaddock.com.au to get a replacement licence sent out. 

8.5 RESETTING DEFAULTS 
 

Clearing the registry and resetting the defaults can sometimes solve software bugs that occur with 

use over time. If requested to do this by the Back Paddock Software support team, the process 

required to do this consists of going through the process of Help>About>Reset Defaults.  

After completing this process you will need to re-enter any changes you have made to the default 

settings e.g. Headings and footers (see section 5.10). Also if you have changed the pathway (Not 

recommended) of the Master Data Base, Scenarios and Map files, then these will need to be reset – 

see sections 6.5, 8.1, 8.3  

8.6 PADDOCK CATEGORY 
 

The paddock categories need to be changed to suit the Master Data Base being used. This can be 

presented as an issue if the master data bas has been changed and the category is wrong. If this has  

mailto:support@backpaddock.com.au
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happened then they will not be displayed in the rotations area summary section. It can be corrected 

by selecting File>Client Master Lists unlock and re select the correct category as it appears in the 

Master Data Base.  

8.7 OTHER ERRORS/PROBLEMS  
 

If you have an error other than those listed above please do the following: 

1. Note down what you were doing in the program just before the error 

2. Send an email support@backpaddock.com.au or phone 1800 557 166 with the details of the 

problem and what you were doing when it occurred. 

o If an error message is showing, take a ‘screen dump’ (copy) of the screen by: 

a. Pressing the “Print Scn” button on your keyboard 

Open a new email, press [CTRL] and [V]  (paste) and send it to 

support@backpaddock.com.au  
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